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About this Manual
TEMPpoint is a family of temperature measurement instruments that includes the DT9871U, 
DT9871, DT8871U, DT8871, DT9872, and DT8872. This manual describes the DT8871U, 
DT8871, and DT8872 Ethernet LXI (LAN eXtensions for Instrumentation) models. 

VOLTpoint is a family of voltage measurement instruments that includes the DT9873 and 
DT8873. This manual describes the DT8873 LXI model.

MEASURpoint™ a family of mixed temperature and voltage measurement instruments that 
includes the DT9874 and DT8874. This manual describes the DT8874 LXI model.

Note: For information on the USB models of TEMPpoint, VOLTpoint, and MEASURpoint, 
refer to the User’s Manual for USB Measurement Instruments.

The first part of this manual describes how to install and set up your instrument, and verify 
that the instrument is working properly.

The second part of this manual describes the features and capabilities of your instrument 
using the IVI-COM instrument driver software. Troubleshooting information is also provided.

Note: If you are programming the instrument using the IVI-COM driver, refer to the 
DtxMeasurement IVI-COM driver online help for more information.

If you are using Measure Foundry to program your instrument, refer to the Measure Foundry 
User’s Manual and online help for more information.

If you are using Standard Commands for Programmable Instruments (SCPI) to program your 
instrument, refer to the SCPI Programmer’s Manual for MEASURpoint for more information.

Intended Audience

This document is intended for engineers, scientists, technicians, or others responsible for 
using and/or programming a TEMPpoint, VOLTpoint, or MEASURpoint instrument. It is 
assumed that you have some familiarity with thermocouples, RTDs, and/or voltages and that 
you understand your application.
11
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How this Manual is Organized 

This manual is organized as follows:

• Chapter 1, “Overview,” summarizes the major features of the TEMPpoint, VOLTpoint, 
and MEASURpoint instruments, as well as the supported software and accessories.

• Chapter 2, “Preparing to Use the Instrument,” describes how to unpack the instrument, 
check the system requirements, install the software, and view the documentation online.

• Chapter 3, “Setting Up and Installing the Instrument,” describes how to apply power to 
the instrument and connect the instrument to the network. 

• Chapter 4, “Wiring Signals,” describes how to wire signals to the instrument. 

• Chapter 5, “Verifying the Operation of Your Instrument,” describes how to verify the 
operation of the instrument with the instrument’s web interface. 

• Chapter 6, “Principles of Operation,” describes the analog input and digital I/O features 
of the TEMPpoint, VOLTpoint, and MEASURpoint instruments in detail.

• Chapter 7, “Troubleshooting,” provides information that you can use to resolve problems 
with your instrument, should they occur.

• Appendix A, “Specifications,” lists the specifications of the TEMPpoint, VOLTpoint, and 
MEASURpoint instruments.

• Appendix B, “Connector Pin Assignments,” describes the pin assignments of the digital 
I/O connector on the TEMPpoint, VOLTpoint, and MEASURpoint instruments.

• Appendix C, “Using the Measurement Application,” describes how to use the 
Measurement Application with a TEMPpoint, VOLTpoint, or MEASURpoint instrument.

• Appendix D, “Configuring Network Settings on Your PC,” describes how to configure the 
network settings of your PC to use Auto-IP or a static IP address.

• Appendix E, “About ISO-Channel Technology,” describes the benefits of ISO-Channel™ 
technology.

• An index completes this manual.

Conventions Used in this Manual

The following conventions are used in this manual:

• Notes provide useful information or information that requires special emphasis, cautions 
provide information to help you avoid losing data or damaging your equipment, and 
warnings provide information to help you avoid catastrophic damage to yourself or your 
equipment.

• Items that you select or type are shown in bold.
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Related Information

Refer to the following documents for more information on using a TEMPpoint, VOLTpoint, or 
MEASURpoint instrument:

• DtxMeasurement IVI-COM Driver online help. For programmers who are developing 
their own application programs using a tool other than Measure Foundry, this document 
describes how to use the IVI-COM driver to access the capabilities of your instrument. 

The IVI-COM driver works with any development environment that supports COM 
programming, including MATLAB® from The MathWorksTM, Microsoft® Visual 
C#®.NET or Visual Basic®.NET, Agilent® VEE Pro, National Instruments™ LabVIEW™ 
or LabWindows™, and so on.

• Measure Foundry manual and online help. For programmers who purchase Measure 
Foundry to easily create custom applications for a TEMPpoint, VOLTpoint, or 
MEASURpoint instrument, these documents describe the functions and capabilities of the 
Measure Foundry software.

• SCPI Programmer’s Manual for LXI Measurement Instruments. For programmers who want 
to use the SCPI interface to program a TEMPpoint, VOLTpoint, or MEASURpoint 
instrument, this document describes the supported SCPI commands and example 
programs for these instruments.

• IVI foundation (www.ivifoundation.org)

• Omega Complete Temperature Measurement Handbook and Encyclopedia® or the Omega 
Engineering web site: http://www.omega.com. Both resources provide valuable information on 
thermocouple types, RTD types, standards, and linearization.

Where To Get Help

Should you run into problems installing or using a TEMPpoint, VOLTpoint, or MEASURpoint 
instrument, the Data Translation Technical Support Department is available to provide 
technical assistance. Refer to Chapter 7 for more information. If you are outside the United 
States or Canada, call your local distributor, whose number is listed on our web site 
(www.datatranslation.com). 
13
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Hardware Features
Data Translation provides a number of LXI (Ethernet) instruments to meet your measurement 
needs, including the following:

• TEMPpoint – a family of temperature measurement instruments 

• VOLTpoint – a family of voltage measurement instruments

• MEASURpoint – a family of mixed temperature and voltage measurement instruments

All of these Ethernet instruments are class C devices that comply with LXI version 1.1. 

The following sections summarize the features of the TEMPpoint, VOLTpoint, and 
MEASURpoint LXI instruments.

TEMPpoint Features

TEMPpoint instruments include the following models: DT8871U, DT8871, and DT8872.

The key features of TEMPpoint instruments are as follows: 

• DT8871U and DT8871:

− Configurable analog input channels for thermocouple or differential voltage inputs; 
easy-access jacks for each channel for quick wiring

− One CJC (cold junction compensation) input for each thermocouple channel

− B, E, J, K, N, R, S, and T thermocouple types supported; the instrument automatically 
linearizes the measurements and returns the data as a 32-bit, floating-point 
temperature values

− Input range of ±0.075 V for the DT8871U (with 0.25 μV RMS A/D noise using no 
software filtering) and ±1.25 V for the DT8871 (with 5 μV RMS A/D noise using no 
software filtering) 

− Break-detection circuitry to detect open thermocouple inputs

• DT8872:

− Configurable analog input channels for RTDs and differential voltage inputs; 
easy-access jacks for each channel for quick wiring

− 100 Ω, 500 Ω, and 1000 Ω platinum RTD types supported using alpha curves of 0.00385 
(European) or 0.00392 (American)

− 4-wire, 3-wire, or 2-wire configurations; the DT8872 automatically linearizes the 
measurements and returns the data as 32-bit, floating-point temperature, resistance, or 
voltage values

− Input range of ±1.25 V 

• One 24-bit, Delta-Sigma A/D converter per channel for simultaneous, high-resolution 
measurements

• ±500 V galvanic isolation channel-to-channel and to the host computer to protect signal 
integrity



Overview
• Throughput rate of up to 10 Samples/s for all channels.

• Software or external, digital trigger on digital input line 0 starts acquisition

• Auto-calibrating front-end resets the zero point on each power-up; in addition, the 
instrument supports anytime calibration, performing an auto-calibration function on 
software command

• Measurement Instrument Calibration Utility allows you to calibrate the instrument in the 
field (see page 21 for more information on this utility)

• 8 opto-isolated digital input lines; you can read the digital input port through the analog 
input data stream for correlating analog and digital measurements

• 8 opto-isolated digital output lines; the outputs are solid-state relays that operate from 
±30 V at currents up to 400 mA (peak) AC or DC

VOLTpoint Features

The key features of VOLTpoint (DT8873) instruments are as follows: 

• Direct connection of analog input channels for differential voltage inputs; removable 
screw terminal blocks for each channel for quick wiring

• One 24-bit, Delta-Sigma A/D converter per channel for simultaneous, high-resolution 
measurements

• ±500 V galvanic isolation channel-to-channel and to the host computer to protect signal 
integrity

• Software-selectable input range of ±10 V, ±100 V, or ±400 V per channel

• Throughput rate of up to 10 Samples/s for all channels

• Software or external, digital trigger on digital input line 0 starts acquisition

• Auto-calibrating front-end resets the zero point on each power-up; in addition, the 
instrument supports anytime calibration, performing an auto-calibration function on 
software command

• Measurement Instrument Calibration Utility allows you to calibrate the instrument in the 
field (see page 21 for more information on this utility)

• 8 opto-isolated digital input lines; you can read the digital input port through the analog 
input data stream for correlating analog and digital measurements

• 8 opto-isolated digital output lines; the outputs are solid-state relays that operate from 
±30 V at currents up to 400 mA (peak) AC or DC
17
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MEASURpoint Features

The standard MEASURpoint (DT8874) instrument provides 16 thermocouple channels, 16 
RTD channels, and 16 high voltage channels.

The key features of MEASURpoint (DT8874) instruments are as follows: 

• Analog Input Channels 0 to 15:

− Configurable channels for thermocouple or differential voltage inputs; easy-access 
jacks for each channel for quick wiring

− One CJC (cold junction compensation) input for each thermocouple channel

− B, E, J, K, N, R, S, and T thermocouple types supported; the instrument automatically 
linearizes the measurements and returns the data as a 32-bit, floating-point 
temperature values

− Input range of ±0.075 V (with 0.25 μV RMS A/D noise using no software filtering) 

− Break-detection circuitry to detect open thermocouple inputs

• Analog Input Channels 16 to 31:

− Configurable analog input channels for RTDs and differential voltage inputs; 
easy-access jacks for each channel for quick wiring

− 100 Ω, 500 Ω, and 1000 Ω platinum RTD types supported using alpha curves of 0.00385 
(European) or 0.00392 (American)

− 4-wire, 3-wire, or 2-wire configurations; the DT8872 automatically linearizes the 
measurements and returns the data as 32-bit, floating-point temperature, resistance, or 
voltage values

− Input range of ±1.25 V 

• Analog Input Channels 31 to 48:

− Direct connection of analog input channels for differential voltage inputs; removable 
screw terminal blocks for each channel for quick wiring

− Software-selectable input range of ±10 V, ±100 V, or ±400 V per channel

• One 24-bit, Delta-Sigma A/D converter per channel for simultaneous, high-resolution 
measurements

• ±500 V galvanic isolation channel-to-channel and to the host computer to protect signal 
integrity

• Throughput rate of up to 10 Samples/s for all channels

• Software or external, digital trigger on digital input line 0 starts acquisition

• Auto-calibrating front-end resets the zero point on each power-up; in addition, the 
instrument supports anytime calibration, performing an auto-calibration function on 
software command

• Measurement Instrument Calibration Utility allows you to calibrate the instrument in the 
field (see page 21 for more information on this utility)
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• 8 opto-isolated digital input lines; you can read the digital input port through the analog 
input data stream for correlating analog and digital measurements

• 8 opto-isolated digital output lines; the outputs are solid-state relays that operate from 
±30 V at currents up to 400 mA (peak) AC or DC
19
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Supported Software
The following software is available for use with the TEMPpoint, VOLTpoint, and 
MEASURpoint instruments:

• Eureka Discovery Utility – This utility helps you locate or "discover" all LXI (Ethernet) 
instruments that are connected to your system and provides the following information 
about your instrument: the IP address, manufacturer, model number, serial number, and 
version of the firmware that is running on your instrument. In addition, you can use this 
utility to configure Windows firewall settings and update the firmware for your Data 
Translation LXI instrument.

• Instrument Web Interface – This built-in interface, described in Chapter 5, allows you to 
verify the operation of your instrument and perform basic functions with Internet 
Explorer and no additional software. Using it, you can configure your instrument, control 
output signals, measure input signals, and save results to disk.

• Measurement Application – This application, developed using Measure Foundry, lets 
you do the following:

− Configure your instrument

− Acquire temperature, voltage, or resistance data from up to 48 analog input channels

− Display acquired temperature, voltage, or resistance data during acquisition

− Set alarm limits for each channel

− Update the value of the digital output lines based on alarm conditions

− Use a chart recorder to display data over time and log it to an .hpf file for later analysis

− Open the last recorded .hpf data file in Microsoft Excel

− View any .hpf data file in a file viewer

You can customize this application to suit your needs using Measure Foundry 
Professional with the Instrument Pak; the source code for this application is included with 
the instrument.

• Measure Foundry – An evaluation version of this software is available for developing 
applications for TEMPpoint, VOLTpoint, or MEASURpoint instruments. Measure 
Foundry is a rapid application development package that provides a system solution for 
all types of measurement instruments. Using Measure Foundry, you can develop complex 
test and measurement applications easily without writing code. Simply drag and drop 
components on a form and configure their property pages to access all elements of your 
instrument.

Measure Foundry supports all LXI instrument classes through IVI-COM. Instruments 
with interfaces such as GPIB, PXI/LXI, RS-232, and USB are supported through SCPI 
commands using the VISA transport layer.

Order the Instrument Pak for Measure Foundry (SP1309-CD) to build your own 
application for the instrument.

• DtxMeasurement IVI-COM driver – This driver provides access to the instrument’s 
functions through a COM server. The IVI-COM driver works in any development 
environment that supports COM programming, including Measure Foundry, MATLAB, 
Visual Basic.NET, Visual C#.NET, Agilent VEE Pro, LabVIEW, LabWindows, and others.
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• SCPI commands – Use SCPI commands to program TEMPpoint, VOLTpoint, or 
MEASURpoint LXI instruments. Refer to the SCPI Programmer’s Manual for LXI 
Measurement Instruments for information on the supported SCPI commands and example 
programs.

• Measurement Instrument Calibration Utility – Users can calibrate a TEMPpoint, 
VOLTpoint, or MEASURpoint instrument in the field using precise calibration equipment 
and the Measurement Instrument Calibration Utility. Since each instrument consists of up 
to 48 individual channels, great care must be taken to ensure that proper warm-up times 
are followed and precise calibration equipment is used.

The calibration utility ships with a comprehensive help file that describes the required 
equipment and calibration procedure, including warm-up times, for each instrument. 

The calibration utility allows you to revert to the factory calibration for any or all 
channels, or revert back to the last user calibration values, if desired. In addition, this 
utility generates a report that lists the starting and ending calibration values for each 
channel, allowing traceability.

Refer to the Data Translation web site (www.datatranslation.com) for information about 
selecting the right software package for your needs.
21
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Accessories
The following optional accessories are available for TEMPpoint, VOLTpoint, or 
MEASURpoint instruments: 

• STP37 screw terminal panel – The STP37 permits easy screw terminal connections for 
accessing the digital I/O signals of a TEMPpoint, VOLTpoint, or MEASURpoint 
instrument. 

• EP333 cable – The EP333 is a 2-meter shielded cable with two 37-pin connectors that 
connects the STP37 screw terminal panel to the digital I/O connector of the instrument.

• Rack-mount kits – To rack mount a single instrument, order a single rack-mount kit (Data 
Translation part number 22927). 

To rack mount two instruments side by side, order a dual rack-mount kit (Data 
Translation part number 22735).
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Getting Started Procedure
The flow diagram shown in Figure 1 illustrates the steps needed to get started using a 
TEMPpoint, VOLTpoint, or MEASURpoint instrument. This diagram is repeated in each 
Getting Started chapter; the shaded area in the diagram shows you where you are in the 
getting started procedure. 

Figure 1: Getting Started Flow Diagram

Set Up and Install the Instrument
(see Chapter 3 starting on page 35)

Wire Signals 
(see Chapter 4 starting on page 45)

Verify the Operation of the Instrument
(see Chapter 5 starting on page 65)

Prepare to Use the Instrument
(see Chapter 2 starting on page 27)
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Set Up and Install the Instrument
(see Chapter 3 starting on page 35)

Wire Signals
(see Chapter 4 starting on page 45)

Verify the Operation of the Instrument
(see Chapter 5 starting on page 65)

Prepare to Use the Instrument
(this chapter)



Preparing to Use the Instrument
Unpacking
Open the shipping box and verify that the following items are present:

• TEMPpoint, VOLTpoint, or MEASURpoint instrument

• EP372 Ethernet cable

• EP361 +5V power supply and cable

• Instrument OMNI CD-ROM 

• For DT8872, DT8874, and DT8874 instruments, a bag of pluggable screw terminable 
blocks and a screwdriver.

If an item is missing or damaged, contact Data Translation. If you are in the United States, call 
the Customer Service Department at (508) 481-3700, ext. 1323. An application engineer will 
guide you through the appropriate steps for replacing missing or damaged items. If you are 
located outside the United States, call your local distributor, listed on Data Translation’s web 
site (www.datatranslation.com).

Once you have unpacked your instrument, check the system requirements, as described in the 
next section.
29



Chapter 2

30
Checking the System Requirements 
For reliable operation, the computer that accesses your instrument requires the following 
configuration: 

• PC with Pentium III, 500 MHz (or higher) processor

• Screen resolution of 1024 x 768 (or higher)

• 256 MB of RAM; 512 MB (or more) recommended

• 50 MB of hard disk space

• Ethernet port

• CD-ROM drive

• Administrator privileges for software installation

• For access to the instrument web interface:

− Java Version 6, Update 5 or greater

− Internet Explorer 6.0 or 7.0 web browser 

Refer to page 67 for more information on installing Java and configuring your browser 
settings

• Acrobat Reader 5.0 or later for viewing documentation

Once you have verified that your system meets the system requirements, install the software, 
as described in the next section. 
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Installing the Software
This section describes how to install the software you need to use your TEMPpoint, 
VOLTpoint, or MEASURpoint instrument.

Prerequisite Software

No prerequisite software is required if you are using a single client to access a TEMPpoint, 
VOLTpoint, or MEASURpoint instrument on the LXI bus, or if you are managing how 
multiple clients concurrently access the instrument on the LXI bus. (In these case, your 
application can use sockets to communicate with the instrument.)

If, however, you want multiple clients to access your instrument on the LXI bus, and you want 
to "lock" access to the instrument so that one client cannot change the configuration of the 
instrument that another client is accessing, you need to install VISA; we recommend either 
Agilent VISA or NI-VISA from National Instruments. You can then use the VISA methods 
viLock/viUnlock to prevent other clients from accessing the instrument.

To install Agilent VISA, do the following:

1. Go to www.agilent.com, enter IO Libraries Suite in the search field, and select Agilent 
IO Libraries Suite 15.0 from the search results.

2. Follow the instructions on Agilent’s web site to download and install the Agilent IO 
Libraries, which include VISA support, VISA COM support, and the Agilent Connection 
Expert tool.

We recommend that you run Data Translation’s Eureka Discovery Utility that is provided 
with the Measurement software to locate your LXI instrument on the network (see page 72 for 
more information). 

Installing the IVI-COM Driver, Measurement Application, and Eureka 
Discovery Utility

The Measurement Application, developed using Measure Foundry, provides a quick way to 
verify that your instrument is working properly. To install the Measurement Application, 
Eureka Discovery Utility, and all the components necessary to use the Measurement 
Application with your instrument, including the IVI-COM driver, perform the following 
steps:

1. Insert the Instrument OMNI CD into your CD-ROM or DVD drive.
The installation program should start automatically, and the Instrument OMNI installation 
program should appear.

2. If the installation program does not start automatically, double-click Setup.exe from the 
CD.
The installation program appears.

3. Click Install from Web (recommended) to get the latest version of the software from the 
web or Install from CD to install the software from the CD.
31



Chapter 2

32
4. If you are installing from the web, perform these steps:

a. Click Measurement Instrument Software and follow the prompts to install the 
software (including the Measurement Application and IVI-COM driver) and related 
documentation.

b. If you wish to install the evaluation version of Measure Foundry, click Measure 
Foundry (Evaluation) from the MEASURpoint Installation web site, and follow the 
prompts to install the software and related documentation.

Note: To use Measure Foundry with TEMPpoint, VOLTpoint, or MEASURpoint 
instruments, select the evaluation version of Measure Foundry Pro + Instruments 
Pak.

c. If you wish to install the Eureka Discovery Utility (recommended), click Eureka 
Discovery Utility from the Measurement Installation web site, and follow the 
prompts to install the software and help file.

5. If you are installing from the Instrument OMNI CD, perform these steps:

a. Click Install Measurement Software.

b. Ensure that Measurement (Software & Application) is selected.

c. If you wish to install the evaluation version of Measure Foundry in addition to the 
Measurement application, also select Measure Foundry (EVAL). 

Note: To use Measure Foundry with TEMPpoint, VOLTpoint, and MEASURpoint 
instruments, select the evaluation version of Measure Foundry Pro + Instruments 
Pak.

d. If you wish to install the Eureka Discovery Utility (recommended), select Eureka 
Discovery Utility.

e. Click Install Selected Features and follow the prompts to install the software.

f. When you are finished with the Instrument OMNI CD, click Quit Installer.

For information on using the Measurement Application to verify the operation of your 
instrument, refer to Chapter 5 starting on page 65.

Installing SCPI Support Software

If you wish, you can develop application programs for TEMPpoint, VOLTpoint, and 
MEASURpoint LXI instruments using SCPI (Standard Commands for Programmable 
Instruments). To install the SCPI example programs and documentation, perform the 
following steps:

1. If you have not already done so, perform the following steps:

a. Insert the Instrument OMNI CD into your CD-ROM or DVD drive.
The installation program should start automatically, and the installation program should 
appear.

b. If the installation program does not start automatically, double-click Setup.exe from 
the CD.
The installation program appears.
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c. Click Install from Web or Install from CD.

2. If you are installing from the web, click Measurement Instrument SCPI Support and 
follow the prompts to install the example programs and documentation.

3. If you are installing from the Instrument OMNI CD, perform these steps:

a. Click Install Additional Software.

b. Click Measurement SCPI Support.

c. Click Install Selected Features and follow the prompts to install the example 
programs and documentation.

d. When you are finished with the Instrument OMNI CD, click Quit Installer.
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Viewing the Documentation

Note: To view the documentation, you must have Adobe Reader 5.0 or greater installed on 
your system. Adobe Reader is provided on the Instrument OMNI CD. If you install Adobe 
Reader from this CD, make sure that you open Adobe Reader and accept the license 
agreement before viewing the documentation. 

You can access the documentation for your instrument from the Windows Start menu as 
follows:

• For documentation about the TEMPpoint, VOLTpoint, or MEASURpoint instrument, click 
Programs -> Data Translation, Inc -> Hardware Documentation -> Measurement User’s 
Manual for LXI Instruments.

• For documentation on the DtxMeasurement IVI-COM driver, click Programs -> IVI -> 
DtxMeasurement -> Documentation.

• For documentation on the Eureka Discovery Utility, click Programs -> Data Translation, 
Inc -> Instrument Support -> Eureka LXI Instrument Discovery.

• For documentation about SCPI support, click Programs -> Data Translation, Inc -> 
Measurement SCPI Support ->SCPI Programmer’s Manual for Measurement.

• For documentation about Measure Foundry, click Programs -> Data Translation, Inc -> 
Measure Foundry -> 5.1.

The following may be helpful when using Adobe Reader: 

• To navigate to a specific section of the document, click a heading from the table of 
contents on the left side of the document.

• Within the document, click the text shown in blue to jump to the appropriate reference 
(the pointer changes from a hand to an index finger).

• To go back to the page from which the jump was made, click the right mouse button and 
Go Back, or from the main menu, click Document, and then Go Back.

• To increase or decrease the size of the displayed document, from the main menu, click 
View, and then Zoom.

• By default, Adobe Reader smooths text and monochrome images, sometimes resulting in 
blurry images. If you wish, you can turn smoothing off by clicking File, and then 
Preferences/General, and unchecking Smooth Text and Images. 
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Note: Your TEMPpoint, VOLTpoint, and MEASURpoint instruments are factory-calibrated. 
Thereafter, yearly recalibration is recommended. Refer to page 104 for more information on 
calibration.

Set Up and Install the Instrument
(this chapter)

Wire Signals
(see Chapter 4 starting on page 45)

Prepare to Use the Instrument
(see Chapter 2 starting on page 27)

Verify the Operation of the Instrument
(see Chapter 5 starting on page 65)
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Connecting the Instrument to the LAN
This section describes how to connect your instrument to the LAN (Local Area Network). Two 
connection schemes are shown:

• Site LAN connections, described on this page

• Private LAN connections, described on page 38

Note: It is recommended that you consult with your network administrator to ensure that 
all network security, performance, and reliability issues are considered when using 
connecting instruments to the LAN.

Connecting to a Site LAN

A site LAN is useful in applications that require access by many users or access by users at 
distributed sites. In this connection scheme, a DHCP (Dynamic Host Configuration Protocol) 
server is used to assign an IP address to the instrument.

Figure 2 shows a typical site LAN connections using a dedicated Ethernet hub, switch, or 
router. Figure 3 shows typical site LAN connections without using a dedicated Ethernet hub, 
switch, or router.

Note: Use standard LAN cables for network connections. TEMPpoint, VOLTpoint, and 
MEASURpoint instruments ship with a standard LAN cable (EP372) for connecting to the 
LAN (RJ45) connector on the rear panel of the instrument.

Figure 2: Typical Site LAN Connections using a Hub, Switch, or Router
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Figure 3: Typical Site LAN Connections Without Using a Hub, Switch, or Router

Connecting to a Private LAN

A private LAN (or subnet) generally involves the direct connection of the instruments to the 
computer, and may include Ethernet hubs or switches. Access to the instruments is limited to 
users that are directly connected to the private LAN; therefore, security, performance, and 
reliably are generally better on a private LAN than on a site LAN.

In this connection scheme, the DHCP (Dynamic Host Configuration Protocol) server is 
typically not available; therefore, Auto-IP is used to assign an IP address to the instrument.

Note: If no DHCP server exists and your PC is set up to use a static IP address, you must 
temporarily reconfigure your PC to use Auto-IP, as described on Appendix D starting on 
page 153.

Connecting Using a Hub or Switch

Figure 4 shows a typical connection scheme when connecting TEMPpoint, VOLTpoint, or 
MEASURpoint instruments to a private LAN using a dedicated Ethernet hub or switch. 

Note: Use standard LAN cables for network connections. The instrument ships with a 
standard LAN cable (EP372) for connecting to the LAN (RJ45) connector on the rear panel of 
the instrument.
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Figure 4: Typical Private LAN Connections using a Hub or Switch

Connecting Directly to a Computer

Optionally, you can connect the TEMPpoint, VOLTpoint, or MEASURpoint instrument 
directly to your computer, creating an ad hoc network, as shown in Figure 5. Be aware that the 
time and date settings of the instrument will not be updated using this connection method. 
Therefore, this connection scheme is generally recommended for quick set up and verification 
only.

Note: TEMPpoint, VOLTpoint, and MEASURpoint instruments do not support the 
Auto-MDIX function; therefore, use a crossover cable rather than a standard LAN cable to 
connect your instrument unless your computer has enabled the Auto-MDIX function. 

Figure 5: Typical Private LAN Connections when Connecting Directly to a Computer
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Applying Power
TEMPpoint, VOLTpoint, and MEASURpoint instruments are shipped with an EP361 +5V 
power supply and cable. To apply power to the instrument, do the following: 

1. Connect the +5 V power supply to the power connector on the rear panel of the 
instrument. Refer to Figure 6.

Figure 6: Attaching a +5 V Power Supply to the Instrument

2. Plug the power supply into a wall outlet. 

Note: For proper grounding of your measurement instrument, ensure that you use the 
power supply and cable (EP361) that is provided with the instrument and that you use all 
three prongs of the cable when connecting it to your wall outlet.

3. Press the Power switch on the rear panel of the instrument, shown in Figure 6, to turn on 
the instrument.
The Power LED on the front panel lights to indicate that power is on.

Figure 7 shows the front panel of the instrument, including the locations of the LEDs.

EP361 +5 V 
Power Supply

To wall 
outlet

Power

Instrument Rear Panel

Digital I/O
LAN

5 V In
Reset



Setting Up and Installing the Instrument
Figure 7: Front Panel of the Instrument

Power LED LAN LED
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Getting an IP Address and Host Name
Once your instrument is connected to the LAN and powered on, the instrument automatically 
requests an Ethernet address from a DHCP (Dynamic Host Configuration Protocol) server, if 
available, and a host name from a DNS (Dynamic Domain Name Service) server, if available. 

If these services are not available on the LAN, the instrument uses Auto-IP to set up its 
TCP/IP configuration. In this case, the IP address is in the range of 169.254.0.0 to 
169.254.255.255 with a subnet mask of 255.255.0.0.

Note: If no DHCP server exists and your PC is set up to use a static IP address, you must 
temporarily reconfigure your PC to use Auto-IP, then configure your instrument to use a 
static IP address, as described in Appendix D starting on page 153.

You can use the instrument’s web interface, described in Chapter 5 starting on page 65, to see 
the IP address and host name that is assigned to your instrument. 

Notes: When programming a TEMPpoint, VOLTpoint, or MEASURpoint instrument, you 
access the instrument through its address string, which consists of an IP address or host 
name, such as TCPIP0::192.43.218.69::inst0::INSTR or TCPIP0::192.43.218.69::SOCKET. If a 
host name was returned by the DNS server, you can also address the instrument using its 
host name, such as TCPIP0::arrakis.datx.com::inst0::INSTR.

For IVI-COM programmers, you can also assign a VISA alias to the instrument. For example, 
rather than addressing the instrument as TCPIP0::192.43.218.69::inst0::INSTR, you can a 
VISA alias, such as TEMPpoint1, instead. See your VISA documentation for more 
information on VISA resource strings and creating VISA aliases.
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Determining Ethernet Activity 
You can use the ENet Link and ENet Activity LEDs on the rear of the instrument, shown in 
Figure 8, with the LAN LED on the front of the instrument, shown in Figure 7, to determine 
the Ethernet activity on your instrument. Table 1 describes the meaning of these LEDs.

Figure 8: Rear Panel of the Instrument

Table 1: Using LEDs to Determine Ethernet Activity

LEDs Color Description

LAN LED 
(on front panel)

Solid Green Instrument has valid IP address.

Blinking Green Instrument identified using the Web 
interface; see page 72 for more information.

Red If the Ethernet link is operational, the 
instrument does not have a valid IP address. 

Otherwise, the Ethernet link is not 
operational.

ENet Link LED
(on rear panel)

Yellow Ethernet link operational.

Off Ethernet link not operational.

ENet Activity LED
(on rear panel)

Green Network traffic detected.

Off No network traffic detected.

ENet Link
LED

ENet Activity
LED

USB LED (not used on this instrument)
LMT LED 
OPN LED 
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Resetting the Instrument
If needed, you can restore the default configuration of your instrument by pressing the Reset 
pin on the rear panel of the instrument, shown in Figure 8 on page 43, until the LAN LED on 
the front panel turns off (which takes approximately 5 seconds), and then releasing the Reset 
pin.

The instrument reboots automatically using the factory-default LAN configuration (DHCP 
and auto-IP enabled); this process typically takes up to 40 seconds to complete. This forces the 
instrument to re-acquire an IP address from the DHCP server, or if that fails, to use Auto-IP to 
get an IP address.

Note: The default configuration overwrites any changes that you have made to the LAN 
configuration (IP address and password) using the instrument’s web interface.

The calibration parameters are not affected by the reset.
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General Wiring Recommendations
Keep the following recommendations in mind when wiring signals to a TEMPpoint, 
VOLTpoint, or MEASURpoint instrument:

• Separate power and signal lines by using physically different wiring paths or conduits.

• To avoid noise, do not locate the instrument and cabling next to sources that produce high 
electromagnetic fields, such as large electric motors, power lines, solenoids, and electric 
arcs, unless the signals are enclosed in a mumetal shield.

• Locate the instrument’s front panel as far away as possible from sources of high or low 
temperatures or strong air currents, such as fans. 

• Prevent electrostatic discharge to the I/O while the instrument is operational.

• When wiring thermocouples, select an appropriate wire length and gauge for each 
thermocouple; in general, use the shortest wire length and largest gauge for the 
application to yield best results. 

• Use shielded wire for maximum rejection of electrical interference.
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Warm-Up Time
For accurate thermocouple measurements, DT8871U and DT8871 TEMPpoint instruments 
and thermocouple channels on the DT8874 MEASURpoint instruments require a warm-up 
time of 45 minutes for the analog circuitry to stabilize.

For accurate high voltage measurements, the DT8873 VOLTpoint instruments and high 
voltage channels on the DT8874 MEASURpoint instruments require a warm-up time of 1 hour 
for the analog circuitry to stabilize.

For accurate RTD measurements, the DT8872 TEMPpoint instruments and RTD channels on 
the DT8874 MEASURpoint instruments require a warm-up time of 1 minute for the analog 
circuitry to stabilize.
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Connecting Thermocouple Inputs
The DT8871U, DT8871, and DT8874 instruments contain Cu-Cu thermocouple jacks for 
connecting thermocouple inputs. 

Note: On the standard DT8874 instrument, channels 0 to 15 correspond to the thermocouple 
input channels.

Internally, these signals are connected in differential mode. You can mix and match the 
following thermocouple types across channels: B, E, J, K, N, R, S, and/or T.

Each Cu-Cu thermocouple input jack is polarized and accepts a mating Cu-Cu plug in the 
appropriate orientation. Table 2 lists the color designations for the + and – polarities of the 
supported thermocouple types for both the ANSI (American) and IEC (International) 
standards. 

For more information on thermocouple standards, refer to the following web site: 
http://www.omega.com/thermocouples.html.

Table 2: Thermocouple Color Designation Standards 

Thermocouple 
Standard

Thermocouple 
Type

Wire Color Coding
+ Polarity

Wire Color Coding
– Polarity

ANSI Type J White Red

Type K Yellow Red

Type T Blue Red

Type E Violet Red

Type S Black Red

Type R Black Red

Type B Gray Red

Type N Orange Red

IEC Type J Black White

Type K Green White

Type T Brown White

Type E Violet White

Type S Orange White

Type R Orange White

Type B Gray White

Type N Pink White
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Figure 9 shows how to connect a thermocouple input to a thermocouple channel.

 

Figure 9: Connecting Thermocouple Inputs
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Connecting RTD Inputs
Each DT8872 and DT8874 contains pluggable screw terminals for connecting RTD inputs. 

Note: On the standard DT8874 instrument, channels 16 to 31 correspond to the RTD input 
channels.

Internally, these signals are connected in differential mode. Figure 10 shows the numbering of 
the screw terminal blocks for RTD connections.

Figure 10: Screw Terminal Block Numbering for RTD Connections

Note: To make wiring easier, use the supplied screwdriver to attach your signals to the 
screw terminal blocks. When you are finished, plug the screw terminal block into the screw 
terminal header that corresponds to the channel to which you are wiring.

The DT8872 supplies each RTD channel with 425 μA of excitation current to prevent 
self-heating. The resistance of the RTD circuit increases gradually, repeatably, and linearly 
with temperature. As the resistance increases, the voltage drop across the RTD also increases. 
The DT8872 reads this voltage drop and automatically converts the voltage to the appropriate 
temperature based on the RTD type. 

The DT8872 and DT8874 support Pt100 (100 Ω Platinum), Pt500 (500 Ω Platinum), and Pt1000 
(1000 Ω Platinum) RTD types using Alpha coefficients of 0.00385 and 0.00392; you can mix 
and match RTD types across RTD channels. Refer to the following web site for more 
information on RTD types: http://www.omega.com.

To connect an RTD input, you can use a 4-wire, 3-wire, or 2-wire connection scheme, 
described in the following subsections. For the best accuracy, use 4-wire RTD connections; this 
connection scheme enables Kelvin sensing to minimize errors due to lead wire resistance. 

1
Current

3
– Sense

2
+Sense

4
Return
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4-Wire RTD Connections

The 4-wire configuration offers the best accuracy with long connection wires, compared to the 
3- and 2-wire configurations. The 4-wire connection scheme eliminates errors due to lead wire 
resistance (RL) and thermal heating. Wire impedance of up to 100 Ω anywhere in the hookup 
is automatically cancelled as long as the sense wires are connected.

Figure 11 shows a 4-wire RTD connection.

 

Figure 11: 4-Wire RTD Connection

3-Wire RTD Connections

The 3-wire configuration eliminates one wire from the 4-wire RTD connection. Lead wire 
resistance (RL) errors in the return wire from –Sense may be introduced unless the voltage 
drop is essentially equal and opposite to the voltage drop across +Sense.

Figure 12 shows a 3-wire RTD connection. 
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Figure 12: 3-Wire RTD Connection

2-Wire RTD Connections

The 2-wire configuration is the least accurate of the RTD wiring configurations because the 
lead wire resistance (RL) and its variation with temperature contribute significant 
measurement errors, particularly if the lead wire is long. If you decide to use the 2-wire 
connection scheme, ensure that you use short lead wire connections.

For example, if the lead resistance is 0.5 Ω in each wire, the lead resistance adds a 1 Ω of error 
to the resistance measurement. Using a 100 Ω RTD (Pt100) with a 0.00385/°C European curve 
coefficient, the resistance represents an initial error of 1 Ω /(0.385Ω /°C) or 2.6°C. Since the 
lead wire resistance changes with ambient temperature, additional errors are also introduced 
in the measurement.

Figure 13 shows a 2-wire RTD connection. 
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*RL is lead wire resistance.
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Figure 13: 2-Wire RTD Connection
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Connecting Voltage Inputs
The way you connect voltage inputs depends on the channel type you are using. This section 
describes how to connect voltage inputs to thermocouple input channels, RTD input channels, 
and high voltage input channels.

Connecting Voltage Inputs to Thermocouple Channels

Figure 14 shows how to connect a differential voltage input to a thermocouple input channel 
on the DT8871U, DT8871, or DT8874 instrument.

Note: On the standard DT8874 instrument, channels 0 to 15 correspond to the thermocouple 
input channels.

 

Figure 14: Connecting Voltage Inputs to a Thermocouple Channel
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Connecting Voltage Inputs to RTD Channels

Figure 15 shows how to connect a voltage input to an RTD channel on a DT8872 or DT8874 
instrument.

Note: On the standard DT8874 instrument, channels 16 to 31 correspond to the RTD input 
channels.

 

Figure 15: Connecting Voltage Inputs to an RTD Channel

The input impedance is well over 100 MΩ using the voltage –Sense and +Sense inputs. 

For best accuracy when connecting voltage inputs, use twisted-pair wires with a dead-ended 
shield connected to pin 4 of the screw terminal block.

Connecting Voltage Inputs to High Voltage Channels

Each DT8873 and DT8874 contains pluggable screw terminals for connecting high voltage 
inputs. 

Note: On the standard DT8874 instrument, channels 32 to 47 correspond to the high voltage 
input channels.

Figure 16 shows the numbering of the screw terminal blocks for high voltage connections.
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Figure 16: Screw Terminal Block Numbering for High Voltage Connections

Note: To make wiring easier, use the supplied screwdriver to attach your signals to the 
screw terminal block. When you are finished, plug the screw terminal block into the screw 
terminal header that corresponds to the channel to which you are wiring.

Figure 17 shows how to connect high voltage inputs to the DT8873 and DT8874.

 

Figure 17: Connecting Voltage Inputs

The input impedance is well over 100 MΩ using the voltage –Sense and +Sense inputs. 

Note: For best accuracy when connecting voltage inputs, use twisted-pair wires with a 
dead-ended shield connected to pin 4 of the screw terminal block.
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Connecting Current Loop Inputs
In some applications, such as solar cell, fuel cell, and car battery testing applications, you may 
want to accurately sense and measure current in a high voltage loop.

TEMPpoint, VOLTpoint, and MEASURpoint instruments provide channel-to-channel 
isolation of ±500 V, meaning that each input can be referenced to ±500 V.

The way you connect current loop inputs depends on the channel type you are using. This 
section describes how to connect current loop inputs to thermocouple input channels, RTD 
input channels, and high voltage input channels.

Connecting Current Loop Inputs to Thermocouple Channels

Thermocouple input channels on the DT8871U and DT8874 have an input range of ±0.075 V. 
Therefore, you can use a 1 Ω series resistor to measure ±0.075 A. Similarly, you can use a 0.1 Ω 
series resistor to measure ±0.75 A. 

Thermocouple input channels on the DT8871 have an input range of ±1.25 V. Therefore, you 
can use a 1 Ω series resistor to measure ±1.25 A. Similarly, you can use a 0.1 Ω series resistor to 
measure ±12.5 A or a 10 Ω series resistor to measure ±0.125 A. 

Figure 18 shows how to wire your signals to measure a current loop. In this example, the input 
is referenced to ±80 V.

Note: On the standard DT8874 instrument, channels 0 to 15 correspond to the thermocouple 
input channels.
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Figure 18: Connecting Current Loop Inputs to Thermocouple Channels

Connecting Current Loop Inputs to RTD Channels

RTD channels on the DT8872 and DT8874 instruments have an input range of ±1.25 V. 
Therefore, you can use a 1 Ω shunt resistor to measure ±1.25 A. Similarly, you can use a 0.1 Ω 
shunt resistor to measure ±12.5 A or a 10 Ω shunt resistor to measure ±0.125 A.

Figure 19 shows how to wire your signals to measure a current loop. In this example, the input 
is referenced to ±80 V.

Note: On the standard DT8874 instrument, channels 16 to 31 correspond to the RTD input 
channels.

1 Ω series resistor

80 VCircuit+

Ch

+–

+

–

Use a 1 Ω series resistor to convert current to voltage.

For thermocouple channels on the DT8871U and DT8874, 1 Ω = 0.075 A = 0.075 V.
For thermocouple channels on the DT8871, 1 Ω = 1.25 A = 1.25 V.

Thermocouple Channel
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Figure 19: Connecting Current Loop Inputs to RTD Channels

Connecting Current Loop Inputs to High Voltage Channels

High voltage channels on the DT8873 and DT8874 instruments have an input range of ±10 V, 
±100 V, or ±400 V. You select the input range for each channel using software.

Note: On older versions of the instrument, the input range was fixed and depended on the 
model you purchased. 

With the 24-bit A/D converter, high current, high side current shunts can be used for 
resolutions of less than 0.01 A on a 100 A range. 

Typical Shunts:

• Vishay WSMS5515
.2 mΩ − 2 Ω − 100 Α − 20 μV 

• Vishay CSM2512S
10 mΩ − 1 Ω − 10 Α − 100 μV

• Deltec MUB-500-50
.1 mΩ − 25 Ω − 500 Α − 50 μV 

1 Ω shunt resistor

Use a 1 Ω shunt resistor to convert current to voltage: 1 Ω = 1.25 A = 1.25 V. 

80 VCircuit+

+

–

RTD Channel

– Sense +Sense

124 3

Shield
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Note: The resolution is ±2 mV on a ±100 V range and ±0.3 mV on the ±10 V range. Since the 
resolution of the ±400 V range is ±8 mV, using current loop inputs with this range is 
impractical in most applications. 

On the standard DT8874 instrument, channels 32 to 47 correspond to the high voltage input 
channels.

Figure 20 shows an example of wiring signals to measure ±20 mA using the ±10 V input 
range. 

Figure 20: Connecting a Current Loop Input to a High Voltage Channel to Measure ±20 mA

250 Ω
shunt resistor 28 V (can be up to ±500 V)±20 mA 

Load

+

–

High Voltage Channel

– Sense +Sense

124 3

Shield

In this example, the input range is ±10 V.
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Connecting Digital I/O Signals
To make digital I/O connections easier, you can use the optional STP37 screw terminal panel 
and EP333 cable with your TEMPpoint, VOLTpoint, or MEASURpoint instrument. Connect 
the STP37 to the digital I/O connector of the instrument as shown in Figure 21:

Figure 21: Connecting the Instrument to the STP37

Figure 22 shows the layout of the STP37 screw terminal panel and lists the assignments of 
each screw terminal.

Figure 22: STP37 Screw Terminal Panel
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Connecting Digital Input Signals

Figure 23 shows how to connect digital input signals (lines 0 and 1, in this case) to the digital 
I/O connector on the TEMPpoint, VOLTpoint, or MEASURpoint instrument. 

Figure 23: Connecting Digital Inputs

Connecting Digital Output Signals

The digital output lines of a TEMPpoint, VOLTpoint, or MEASURpoint instrument act as 
solid-state relays. The customer-supplied signal can be ±30 V at up to 400 mA (peak) AC or 
DC. 

You can use the digital output lines of the instrument to control solid-state or mechanical 
relays or high-current electric motors. Figure 24 shows how to connect digital output signals 
to line 0 of the instrument to control a motor relay.

DIN 0 +

DIN 1 +

TTL Outputs

Instrument 
Digital I/O Connector

DIN 0 –

DIN 1 –

1 kΩ*

+5 V*

*1 kΩ pull-up to +5 V required for TTL outputs.

pin 21

pin 1

pin 20

pin 2
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Figure 24: Switching up to 30 V at 400 mA

Digital Out 0

Digital Out 0pin 10

120 V AC
or 240 V AC

Relay

Motor

10 A 
Fuse

NeutralHot

30V DC @ 400 mA

+ *–
pin 29

Instrument
Digital I/O Connector

*Output can switch AC or DC.

Controlled by
Software
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You can verify the operation of your instrument using the instrument’s web interface. 

You can configure, measure, and control the instrument either locally or remotely using this 
interface.

You can also use the provided Measurement Application, developed in Measure Foundry, for 
more complex data analysis. This chapter focuses on verifying your instrument using the web 
interface; refer to Appendix C starting on page 139 for information on using the Measurement 
Application.

Set Up and Install the Instrument
(see Chapter 3 starting on page 35)

Wire Signals
(see Chapter 4 starting on page 45)

Verify the Operation of the Instrument
(this chapter)

Prepare to Use the Instrument
(see Chapter 2 starting on page 27)
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Before Using the Web Interface
This section describes system requirements and browser settings for proper operation of the 
instrument’s web interface.

Note: At any instant, up to 8 clients can access the instrument concurrently using the web 
interface.

Up to 12 additional clients can access the instrument concurrently using SCPI commands 
over VISA or sockets. Of these, 4 can be VXI-11 clients, which use the ::SOCKETS or 
VISA::INSTR resource to access the instrument. 

At this time, the web and SCPI interfaces cannot be "locked;" therefore, one client can change 
the configuration of the instrument that another client is accessing. However, you can 
optionally lock the VXI-11 interface using the VISA APIs viLock/viUnlock; this prevents 
other VXI-11 clients (including VXI-11 discovery) from accessing the instrument. Refer to the 
SCPI documentation for your instrument for more information on supported SCPI 
commands.

Java Requirements

Before using the instrument web interface, ensure that your computer has Version 6, Update 5 
or greater of Java installed; this version of Java installs version 1.6 of the Java plug-in. To 
download or upgrade Java, go to www.java.com.

To verify that you have version 1.6 of the Java plug-in installed, do the following:

1. Launch version 6.0 or 7.0 of Internet Explorer.

2. From the Internet Explorer browser, select Tools -> 
Sun Java Console.
The Java Console window appears.

3. Verify that version 1.6 or greater of the Java plug-in installed:

Internet Explorer Browser Settings

For proper operation of the instrument’s web interface, ensure that your Internet Explorer 6.0 
or 7.0 browser is configured as follows:

• JavaScript (Active Scripting) must be enabled

• Security level of the instrument’s IP address must be Medium-high or lower

• Pop-up blockers must be disabled
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The following sections describe how to configure these settings.

JavaScript

To enable JavaScript (also referred to as Active Scripting), perform the following steps:

1. From the Internet Explorer browser, select Tools -> Internet Options.

2. Click the Security tab.

3. Select Internet, and then click Custom Level.

4. Scroll down to the Scripting section.

5. Under Active Scripting, select Enable, and then click OK.

Security Levels

By default, the IP address of the instrument is added to the Internet zone. If you'd rather leave 
the settings of the Internet zone at a level higher than Medium-high, then you can add the IP 
address of the instrument to either the Local intranet or Trusted sites zone and configure the 
security level of that zone to Medium-high or lower.

The following section describe how to configure each zone.

Internet Zone

To configure the security level of the instrument’s IP address in the Internet zone, perform the 
following steps:

1. From the Internet Explorer browser, select Tools -> Internet Options.

2. Click the Security tab.



Verifying the Operation of Your Instrument
3. Select Internet, click Default Level, and move the slide bar to select a security level of 
Medium-high or lower.

4. Click OK.

Local Intranet Zone

To add the instrument’s IP address to the Local intranet zone and configure its security level, 
do the following:

1. From the Internet Explorer browser, select Tools -> Internet Options.

2. Click the Security tab.

3. Click Local intranet, and click Sites.

4. Select which web sites to add to the zone, and then click Advanced.

5. Enter the IP address of the instrument to the zone, and click Add.
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6. Click OK.

7. Click Default Level, and move the slide bar to select a security level of Medium-high or 
lower.

8. Click OK.

Trusted Sites Zone

To add the instrument’s IP address to the Trusted sites zone and configure its security level, 
do the following:

1. From the Internet Explorer browser, select Tools -> Internet Options.

2. Click the Security tab.

3. Click Trusted sites, and click Sites.

4. Enter the IP address of the instrument to the zone (note that the address must be prefaced 
by (https://), and click Add.

5. Click OK.

6. Click Default Level, and move the slide bar to select a security level of Medium-high or 
lower.

7. Click OK.

Pop-up Blockers

To disable pop-up blockers, perform the following steps:

a. From the Internet Explorer browser, select Tools ->Pop-up Blocker.

b. Select Turn Off Pop-up Blocker.
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Associating CSV Files with Microsoft Excel or Notepad

If files with the .CSV extension do not have the proper file associations/actions set up, then 
clicking Download in the Download Measurements page of the instrument web interface will 
not present the option of saving the data to a file or loading the data to an application, such as 
Microsoft Excel® or Microsoft® Notepad, that can display it. Instead, the data will be 
displayed in the browser. 

To associate a CSV file with Microsoft Excel or Notepad, perform the following steps:

1. From the Windows Control Panel, open the Folder Options dialog, and select File Types. 

2. Scroll down to the CSV entry and select it. (If it is not in the list add it as a new file type by 
selecting New and entering CSV).

3. Click Advanced to access the Edit File Type dialog box. 

4. Click New to access the New Action dialog box. 

5. Enter Open in the Action: edit field.

6. Click Browse and find Excel.exe (typically located in C:\Program Files\Microsoft 
Office\OFFICExx\EXCEL.EXE) or Notepad.exe (typically located in 
C:\Windows\Notepad.exe) on your system, and then click OK.

7. Click OK. 

Now when you click Download on the Download Measurements web page, you should see a 
dialog box asking if you want to Open or Save the data in the appropriate application.
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Locating Your Instrument on the LAN
To access the web interface of your instrument, you must determine its IP address on your 
TCP/IP network. 

Note: Discovery works only for devices on the same subnet.

We recommend that you run Data Translation’s Eureka Discovery Utility that is provided 
with the instrument to locate your instrument on the network quickly. Alternatively, you can 
use other LXI discovery tools, such as Agilent Connection Expert, if you have them installed 
on your computer. Or you can check your router’s address assignments or locate the 
instrument’s MAC (Ethernet hardware) address in your DHCP server log.

Running the Eureka Discovery Utility 

To use the Eureka Discovery Utility, from the Windows Start menu, click Programs -> Data 
Translation, Inc -> Instrument Support -> Eureka LXI Instrument Discovery.
A screen similar to the one shown in Figure 25 appears.

Figure 25: Eureka LXI Discovery Utility

If you are having trouble seeing your instrument in this list, check your Windows firewall 
settings using the information in the next section; otherwise, skip this section and continue 
with “Launching the Web Interface” on page 76.



Verifying the Operation of Your Instrument
Configuring Windows Firewall Settings

If you are having trouble seeing your instrument using the Eureka Discovery Utility, check 
your Windows firewall settings by doing the following:

1. Right click in the tile bar of the Eureka Discovery Utility.
The following menu options appear:

2. Click the Firewall Configuration... option.
The following window appears:
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3. From the General tab, select the On (recommended) setting for proper operation of the 
Eureka Discovery Utility.

4. Click the Exceptions tab, and ensure that Eureka LXI Instrument Discovery is included in 
the list of exceptions:
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5. If Eureka LXI Instrument Discovery is not included in the exception list, add the utility to 
the list of exceptions by doing the following:

a. Click Add Program...

b. Browse to C:\Program Files\Data Translation\Instrument Support\Eureka.exe.
The Eureka LXI Instrument Discovery utility appears in the window:

Eureka LXI Instrument 
Discovery must be 

listed as an exception
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c. Click OK to add the utility to the list of exceptions.

d. Click OK to exit from the Windows Firewall Configuration menu.

Launching the Web Interface

From the Eureka utility, double-click the appropriate IP address to open the web pages for 
your instrument using your default web browser. Alternatively, you can enter the IP address 
of your instrument directly in your Internet Explorer address bar to see the instrument’s web 
interface.

The main web page, similar to the following screen, shows information about your instrument 
on the network: 
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If you have multiple instruments connected to the network, you can click "Turn ON front 
panel identification indicator" to light the LAN LED on the instrument, described on page 41, 
to indicate the device you are using.

To change the description, IP address, or time source associated with the instrument, click the 
Modify links to navigate to the LAN Configuration page, described on page 78.

To change the time zone associated with the instrument, click the Modify link. The following 
screen appears:

You specify the time zone that is used by the instrument as an offset (either + or –) from GMT 
(Greenwich Mean Time). The specified hour and minute is added to the UTC (Coordinated 
Universal Time) time that is maintained by the instrument. For example choosing –5 hours, 0 
minutes sets the current time zone used by the instrument to five hours and 0 minutes behind 
GMT. 
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Configuring the Instrument
Web pages are provided for configuring the following aspects of your instrument: 

• Local Area Network (LAN) settings

• Channels that you want to measure

• Scan rate 

• Filter

• Alarm limits

• Digital I/O lines

LAN Configuration

Use the Configuration -> LAN web page to configure the Local Area Network (LAN) settings 
for the instrument. A screen similar to the following appears:

When you first access your instrument, the LAN settings that the instrument obtained 
through DHCP or AutoIP should be sufficient. If you need to make changes later, click the 
Modify button to enable changes.

Note: If you want to assign a static IP address, ensure that you uncheck the checkbox called 
Automatic private IP address enabled.
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When you click Modify, you must supply a password for the instrument. The username is 
sysadmin; it cannot be changed. The default password is user. You can change the password 
on this page. Note that the new password goes into effect after the instrument reboots. If you 
are prompted for a password before the instrument reboots, you must enter your original 
password.

Contact your system administrator and view the instrument’s built-in help pages to determine 
the correct LAN settings.

Channel Configuration

Use the Configuration -> Channel web page to enable the channels that you want to measure, 
specify the sensor to use for each channel, and add a label to describe each channel, if desired. 
A screen similar to the following appears:

To change your channel configuration, do the following: 

1. Under Enable Channel, check the boxes next to the channels that you want to collect data. 
You can use the Enable All and Disable All buttons for quick configuration of many 
channels.

2. Under Type, select the sensor type for each configured channel from the drop-down list 
boxes. If all the channels are of the same type (thermocouple, RTD, or voltage), you can 
use the Set all button to change all channels to the sensor type specified in the heading’s 
drop-down list box.

3. Describe the channels, if desired, by entering text in the Label field corresponding to the 
channel that you want to describe. 
79



Chapter 5

80
4. Click Save configuration to apply your changes. If you do not save before leaving this 
page, your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous 
configuration, if desired.

Scan Rate

Use the Configuration -> Scan Rate web page to set the scan rate for all channels on the 
instrument. A screen similar to the following appears:

 

To change your instrument’s scan rate, do the following: 

1. Type a value, in Hertz, between the minimum and maximum shown in the Scan Rate 
field.

Note: The scan rate that you specify is rounded to the closest "correct" value that the 
instrument can accept without error. Internally, the 10 Hz clock is divided by an integer in 
the range of 1 to 65535 (the internal clock divider) to determine the closest value. When 
you save the scan rate configuration, the actual scan rate is shown.

2. Click Save configuration to apply your changes. If you do not save before leaving this 
page, your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous 
configuration, if desired.
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Filter Configuration

Use the Configuration -> Filter web page to configure the filter type used by the instrument. 
A screen similar to the following appears:

You can choose one of the following filter types:

• Raw – No filter. Provides fast response times, but the data may be difficult to interpret. 
Use when you want to filter the data yourself.

The Raw filter type returns the data exactly as it comes out of the Delta-Sigma A/D 
converters. Note that Delta-Sigma converters provide substantial digital filtering above 
the Nyquist frequency.

Generally, the only time it is desirable to use the Raw filter setting is if you are using fast 
responding thermocouples, sampling them at higher speeds (> 1 Hz), and need as much 
response speed as possible.

• Moving average – (The default filter setting.) Provides a compromise of filter 
functionality and response time. This filter can be used in any application.

This low-pass filter takes the previous 16 samples, adds them together, and divides by 16. 
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Alarm Limits Configuration

Use the Configuration -> Limits web page to define alarm conditions for specific enabled 
channels that you want to measure. A screen similar to the following appears.

If the alarm condition occurs, the specified digital output line is turned on. 

To set up limit checking, do the following:

1. Under Limit, click the Enable buttons next to the channels for which you want to define 
limits. You can use the Disable All button to quickly stop limit checking on all channels. 
For each channel:

2. Enter a value in the Low Limit text box.

3. Enter a value in the High Limit text box.

4. (Optional) Select a Digital Output line to set from the drop-down list box for this channel. 
This line is set to 1 when the limit range (high or low) is exceeded. 

When multiple channels are configured to set a digital output line, a logical OR condition 
exists between them, and any value out of range sets the line to 1.

5. Click Save configuration to apply your changes. If you do not save before leaving this 
page, your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous 
configuration, if desired.
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Digital Input and Trigger Configuration

Use the Configuration -> Digital Input & Trigger web page to configure the digital input 
lines of your instrument:

To change your digital input configuration, do the following: 

1. Describe the digital input lines, if desired, by entering text in the Label field 
corresponding to the digital input line that you want to describe.

2. To enable use of an external, digital trigger on digital input line 0, click the Enable 
checkbox under the External trigger heading.

3. Click Save configuration to apply your changes. If you do not save before leaving this 
page, your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous 
configuration, if desired.
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Digital Output Configuration

Use the Configuration -> Digital Out web page to configure the digital output lines of your 
instrument:

To change your digital output configuration, do the following: 

1. Describe the digital output lines, if desired, by entering text in the Label field 
corresponding to the digital output line that you want to describe.

2. Click Save configuration to apply your changes. If you do not save before leaving this 
page, your changes are lost.

You can also click the Discard changes button (before you save) to return to the previous 
configuration, if desired.
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Measuring Data and Controlling the Instrument
Use the Control web pages start or stop data acquisition on the sensor channels or to update 
the value of the digital output line.

Starting and Stopping a Scan

To start or stop a scan, use the Measurement & control -> Channel web page.

Press the Start scan button to begin acquiring data from the sensors. The measurements are 
displayed on the screen:
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Notice the following aspects of the display:

• When acquiring data, the Start scan button changes to say Stop scan and the currently 
configured scan rate is displayed. 

• Each box on the Meter tab represents one of the analog input channels, in the same 
position as the physical connectors. 

• If you configured custom labels for some of the channels, those labels are shown here 
rather than the channel numbers. 

• Red boxes indicate that the value is out of range for the specified sensor type. 

• The values are updated only for the channels that you enabled, and at the scan rate you 
configured.

Press the Stop scan button to stop acquiring data from the sensors. 
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Controlling the Digital Outputs

Use the Measurement & control -> Digital Output web page to view the current state of the 
digital output lines, and manually change them if desired. A screen similar to the following 
appears:

Green indicates that the digital output line/relay is closed; red indicates that the digital 
output line/relay is open.

Note: You cannot change the configuration of digital output lines that were configured for 
limit checking on the Configuration -> Limits page.

To change the status of a digital output line/relay, click the Open/Close toggle buttons under 
the Change State heading for the digital output lines that you want to change. You can use 
these controls to activate or deactivate an external device based on criteria other than 
temperature that you define.
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Reading the Digital Inputs

While the instrument is scanning, you can use the Measurement & control -> Digital Input 
web page to view the current value of the digital input port. A screen similar to the following 
appears:

If you configured custom labels for the digital input lines, those labels are shown here.

The Current state LEDs show green if the digital input line is on (relay is closed) or red if the 
digital input line is off (relay is open).
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Downloading Measurements

Note: Before using this feature, ensure that you have associated CSV files with Microsoft 
Excel or Notepad, described on page 71, or the data will be displayed in the browser and not 
saved to a file.

You can use the File -> Download Measurements web page to download your measurement 
results, including timestamp and limit values, if applicable, to disk. A screen similar to the 
following appears:

 

Measurements taken by the instrument are stored in a large circular buffer; when the buffer is 
full, the oldest data is overwritten with the most recent data. 

To download your data, do the following: 

1. Click the Download button on this page.

If scanning has been stopped, all the data in the buffer is downloaded to a 
comma-separated CSV file, starting with the most recent data.

Most Recent Data

Downloaded Data

Beginning of Buffer

Circular Buffer

End of Buffer
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If scanning is in progress, a snapshot of the data from the most recent data (at the time 
that the Download button was clicked) to the oldest data in the buffer is downloaded to a 
comma-separated CSV file. 

2. In the resulting dialog box, choose Open or Save. 

− If you choose Open, the CSV file opens in the associated application (Microsoft Excel 
or Notepad). 

− If you choose Save, you can open the CSV file in Microsoft Excel, Notepad, or other 
utilities for analysis at a later time.

Under some circumstances, your data may be displayed in a frame in the browser, or Excel 
may open the data in the frame; an example follows: 

Change your Microsoft Excel, Microsoft Explorer, and Internet Explorer settings to turn off 
these behaviors and open your files directly in Excel. 

Most Recent Data

Oldest Data

Downloading Data

Beginning of Buffer End of Buffer

Circular Buffer
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Block Diagrams
This section includes the block diagrams for the DT8871U, DT8871, and DT8872 TEMPpoint 
instruments, DT8873 VOLTpoint instrument, and DT8874 MEASURpoint instruments.

DT8871U Block Diagram

Figure 26 shows the block diagram of the DT8871U TEMPpoint instrument.

Figure 26: Block Diagram of the DT8871U TEMPpoint Instrument
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DT8871 Block Diagram

Figure 27 shows the block diagram of the DT8871 instrument.

Figure 27: Block Diagram of the DT8871 TEMPpoint Instrument
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DT8872 Block Diagram

Figure 28 shows the block diagram of the DT8872 TEMPpoint instrument.

Figure 28: Block Diagram of the DT8872 TEMPpoint Instrument
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DT8873 Block Diagram

Figure 29 shows the block diagram of the DT8873 VOLTpoint instrument.

Figure 29: Block Diagram of the DT8873 VOLTpoint Instrument
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DT8874 Block Diagram

Figure 30 shows the block diagram of the DT8874 MEASURpoint instrument.

Figure 30: Block Diagram of the DT8874 MEASURpoint Instrument
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Analog Input Features
This section describes the following features of the analog input (A/D) subsystem on 
TEMPpoint, VOLTpoint, and MEASURpoint instruments:

• Analog input channels, described on this page

• Input ranges, described on page 102

• Resolution, described on page 104

• Calibration, described on page 104

• Sample clock, described on page 105

• Trigger source, described on page 105

• Conversion modes, described on page 105

• Filtering, described on page 107

• Data format, described on page 108 

• Error conditions, described on page 108 

Analog Input Channels

TEMPpoint, VOLTpoint, and MEASURpoint instruments provide up to 48 analog input 
channels. The number of channels and the channel types supported (thermocouple, RTD, or 
voltage input) depend on the specific instrument model you purchased, as shown in Table 3.

Table 3: Number and Type of Analog Input Channels 

Instrument 
Type Models

# of Analog Input 
Channels Channel Types

TEMPpoint DT8871U-8 and DT8871-8 8 8 thermocouple inputs (numbered 0 to 7)

DT8871U-16 and DT8871-16 16 16 thermocouple inputs (numbered 0 to 15)

DT8871U-24 and DT8871-24 24 24 thermocouple inputs (numbered 0 to 23)

DT8871U-32 and DT8871-32 32 32 thermocouple inputs (numbered 0 to 31)

DT8871U-40 and DT8871-40 40 40 thermocouple inputs (numbered 0 to 39)

DT8871U-48 and DT8871-48 48 48 thermocouple inputs (numbered 0 to 47)

DT8872-8 8 8 RTD inputs (numbered 0 to 7)

DT8872-16 16 16 RTD inputs (numbered 0 to 15)

DT8872-24 24 24 RTD inputs (numbered 0 to 23)

DT8872-32 32 32 RTD inputs (numbered 0 to 31)

DT8872-40 40 40 RTD inputs (numbered 0 to 39)

DT8872-48 48 48 RTD inputs (numbered 0 to 47)
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Thermocouple Input Channels

For channels that support thermocouples, you can attach a voltage input or any of the 
following thermocouple types in a mix and match fashion: B, E, J, K, N, R, S, and/or T. 

By default, these channels are configured for voltage inputs. You can specify the thermocouple 
types for channels over the LAN using the web interface, as described in “Channel 
Configuration” on page 79, in software using the Change Configuration dialog in the supplied 
Measurement Application, or by using an API call in your application program. You can also 
use standard SCPI commands over VISA or sockets, if desired.

Note: In a mix-and-match system, it is easy to accidentally mismatch the software and 
hardware configuration for a channel. Therefore, it is recommended that you pay particular 
attention when configuring channels, since the resultant errors may be not large enough to 
notice initially, but may be significantly larger than the accuracy specification for the 
instrument.

Since each channel has its own 24-bit A/D, analog inputs are measured simultaneously. Refer 
to page 105 for more information on specifying the channels for a scan.

Table 4 lists the supported measurement range for each thermocouple type. (Refer to page 102 
for information on the supported input range for voltage measurements.)

VOLTpoint DT8873-8 8 8 high voltage inputs (numbered 0 to 7)

DT8873-16 16 16 high voltage inputs (numbered 0 to 15)

DT8873-24 24 24 high voltage inputs (numbered 0 to 23)

DT8873-32 32 32 high voltage inputs (numbered 0 to 31)

DT8873-40 40 40 high voltage inputs (numbered 0 to 39)

DT8873-48 48 48 high voltage inputs (numbered 0 to 47)

MEASURpoint DT8874-16T-16R-16V 48 16 thermocouple inputs (numbered 0 to 15)

16 RTD inputs (numbered 16 to 31)

16 high voltage inputs (numbered 32 to 47)

Table 3: Number and Type of Analog Input Channels  (cont.)

Instrument 
Type Models

# of Analog Input 
Channels Channel Types
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Refer to Appendix A for the thermocouple accuracy of thermocouple channels over the 
dynamic range of the instrument.

Cold Junction Compensation

Each thermocouple channel has its own cold-junction compensation (CJC) at the input. The 
software reads the value of the CJC input along with the value of the analog input channel 
and automatically corrects for errors based on the specified thermocouple type and the 
thermocouple linearization data stored in onboard ROM.

A separate multiplexed A/D is used to acquire all the CJC input values. The software takes 
care of correlating the CJC measurements with the analog input measurements.

Note: The software provides the option of returning CJC values in the data stream. This 
option is seldom used, but is provided if you want to implement your own temperature 
conversion algorithms in software when using continuous operations. Refer to page 108 for 
more information on this feature.

Open Thermocouple Detection

Break detection circuitry (+10 nA on the DT8871U and DT8874; +100 nA on the DT8871) is 
provided for thermocouple channels to ensure that open thermocouples are detected. The 
Open (OPN) LED on the rear panel lights when this condition occurs; see Figure 8 on page 43 
for the location of this LED.

Table 4: Supported Measurement Range for Each Thermocouple Type

Thermocouple 
Type

Supported Measurement Range

Minimum Maximum

B 0°  C (32°  F) 1820° C (3308° F)

E –200°  C (–328°  F) 1000° C (1832° F)

J –210°  C (–346°  F) 1200°  C (2192° F)

K –200°  C (–328°  F) 1370° C (2498° F)

N –200°  C (–328°  F) 1300° C (2372° F)

R –50°  C (–58°  F) 1750° C (3182° F)

S –50°  C (–58°  F) 1750° C (3182° F)

T –200°  C (–328°  F)  400° C (752° F)
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In addition, the software returns the value SENSOR_IS_OPEN (99999 decimal) for any 
channel that was configured for a thermocouple input and has either an open thermocouple 
or no thermocouple connected to it. This value is returned anytime a voltage greater than 100 
mV is measure on the input, since this value is greater than any legitimate thermocouple 
voltage. 

If the channel is configured for a voltage input (not a thermocouple type), the Open (OPN) 
LED never lights and the SENSOR_IS_OPEN value is not returned. Instead, the voltage value 
is returned. If no input is connected to the channel, the software returns a value of 
approximately 0.7 V due to the open thermocouple detection pull-up circuit.

RTD Channels

For channels that support RTDs, you can attach a voltage input or any of the following RTD 
types in a mix and match fashion: Platinum 100 Ω (Pt100), Platinum 500 Ω (Pt500), or Platinum 
1000 Ω (Pt1000) RTD using an European alpha curve of 0.00385 or an American alpha curve of 
0.00392. The supported temperature measurement range for these RTD types is –200°  C 
(–328° F) to 850°  C (1562°  F). You can also measure a resistance value between 0 and 4k Ohms, 
if desired. (Refer to page 102 for information on the supported input range for voltage 
measurements.)

By default, all channels are configured for voltage inputs. You can specify the RTD types for 
channels over the LAN using the web interface, as described in “Channel Configuration” on 
page 79, in software using the Change Configuration dialog in the supplied Measurement 
Application, or by using an API call in your application program. You can also use standard 
SCPI commands over VISA, if desired.

Note: In a mix-and-match system, it is easy to accidentally mismatch the software and 
hardware configuration for a channel. Therefore, it is recommended that you pay particular 
attention when configuring channels, since the resultant errors may be not large enough to 
notice initially, but may be significantly larger than the accuracy specification for the 
instrument.

Since each channel has its own 24-bit A/D, analog inputs are measured simultaneously. Refer 
to page 105 for more information on specifying the channels for a scan.

Input Ranges

The input voltage range that is supported by your TEMPpoint, VOLTpoint, or MEASURpoint 
instrument depends on the specific instrument model that you purchased, as shown in Table 
5.
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Out of Range Data for Thermocouple Channels

Each thermocouple type corresponds to an allowable voltage range. If a voltage is measured 
on the input that is outside of the legal range for the selected thermocouple type, the channel 
may be configured for the wrong type of thermocouple or something other than a 
thermocouple may be connected to the channel.

For channels configured with a thermocouple type of None (voltage), the Limit (LMT) LED on 
the rear panel of the instrument lights to alert you when the voltage is out of range; see Figure 
8 on page 43 for the location of this LED. 

For channels configured with a thermocouple type other than None (voltage), the LMT LED 
lights when the temperature limit is out of range for the specified thermocouple type.

In addition, if the input voltage is less than the legal voltage range for the selected 
thermocouple type, the software returns the value TEMP_OUT_OF_RANGE_LOW (–88888 
decimal). If the input voltage is greater than the legal voltage range for the selected 
thermocouple type, the software returns the value TEMP_OUT_OF_RANGE_HIGH (88888 
decimal).

Note: If you are continuously measuring from a properly configured thermocouple input 
channel and the thermocouple opens or becomes disconnected, the open thermocouple 
pull-up circuit causes the input voltage to rise to approximately 0.7 V over a few seconds.

In this case, the temperature value rises very quickly, and you will receive the 
TEMP_OUT_OF_RANGE_HIGH (88888 decimal) value followed by the OPEN_SENSOR 
(99999 decimal) value. In this case, the OPN LED lights when the open thermocouple is 
detected and the LMT LED lights when the temperature limit is out of range for the 
thermocouple type.

Table 5: Supported Input Ranges 

Instrument 
Type Models Input Range

TEMPpoint DT8871U ±0.75 V for all channels

DT8871 ±1.25 V for all channels

DT8872 ±1.25 V for all channels

VOLTpoint DT8873 ±10 V, ±100 V, or ±400 V 
(software-selectable for each channel)a

a. Older versions of this instrument had fixed input ranges of ±10 V, ±100 V, or ±400 V, depending on 
the model purchased.

MEASURpoint DT8874-16T-16R-16V ±0.75 V for channels 0 to 15;
±1.25 V for channels 15 to 31; 
±10 V, ±100 V, or ±400 V for channels 32 to 47 
(software-selectable for each channel)
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Out of Range Data for RTD Channels

Each RTD type corresponds to an allowable voltage range. If a voltage is measured on the 
input that is outside of the legal range for the selected RTD type, the channel may be 
configured for the wrong type of RTD or something other than an RTD may be connected to 
the channel.

For channels configured with a RTD type of voltage, the Limit (LMT) LED on the rear panel of 
the instrument lights to alert you when the voltage is out of range (greater than +1.25 V or less 
than –1.25 V); see page 43 for the location of this LED. For channels configured with an RTD 
type other than voltage, the LMT LED lights when the temperature limit is out of range for the 
specified RTD type.

In addition, if the input voltage is less than the legal voltage range for the selected RTD type, 
the software returns the value TEMP_OUT_OF_RANGE_LOW (–88888.0 decimal). If the 
input voltage is greater than the legal voltage range for the selected RTD type, the software 
returns the value TEMP_OUT_OF_RANGE_HIGH (88888.0 decimal). 

Out of Range Data for High Voltage Channels

Each voltage input channel has an allowable voltage range (±10 V, ±100 V, or ±400 V). You 
configure the input range for each channel using software. If a voltage is measured on the 
input that is outside of the legal range for that channel, the Limit (LMT) LED on the rear panel 
of the instrument lights to alert you; see page 43 for the location of this LED. 

Resolution

TEMPpoint, VOLTpoint, and MEASURpoint instruments support a resolution of 24 bits for 
the analog input subsystem; you cannot specify the resolution in software.

Calibration

Each TEMPpoint, VOLTpoint, and MEASURpoint instrument is factory-calibrated to meet or 
exceed its published specifications using standards traceable to NIST.

The calibration process includes multiple steps. First, the A/D on each channel is calibrated 
for offset and gain; these values (including the zero point) are stored in ROM. Then, each CJC 
circuit is calibrated for thermocouple input channels, and the reference current is 
characterized for RTD channels.

While each instrument was designed to preserve high accuracy measurements over time, it is 
recommended that your instrument be recalibrated every year to ensure that it meets or 
exceeds specifications.

You can calibrate your instrument in the field using precise calibration equipment and the 
Measurement Instrument Calibration Utility, described on page 21. Optionally, you can return 
your instrument to Data Translation for recalibration. For information on factory recalibration, 
contact Data Translation at 508-481-3700, ext. 1323 (if you are in the USA) or call your local 
distributor (if you are located outside the USA); see our web site (www.datatranslation.com) 
for the name and telephone number of your nearest distributor.
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In addition, each instrument auto-calibrates on each power-up cycle to guarantee 
high-accuracy measurements. This process, also known as auto-zeroing, resets the zero point 
of each A/D. You can also auto-calibrate the instrument at any time (as long as acquisition is 
not in progress) using a software command. Refer to your software documentation for more 
information on the auto-calibration feature.

Sample Clock Source

TEMPpoint, VOLTpoint, and MEASURpoint instruments support an internal clock with a 
maximum sampling rate of 10 Samples/s.

Use software to specify an internal clock source and a clock frequency between 
0.000152590219 Hz and 10.0 Hz. 

Note: The clock frequency that you specify is rounded to the closest "correct" value that the 
instrument can accept without error. Internally, the 10 Hz clock is divided by an integer in 
the range of 1 to 65535 (the internal clock divider) to determine the closest value. Using 
software, you can query this setting to determine the actual clock frequency that is used.

When the continuous operation is started, all the channels specified in the channel list are read 
simultaneously at the specified clock frequency.

Trigger Source

A trigger is an event that occurs based on a specified set of conditions. Acquisition starts when 
the instrument detects the initial trigger event and stops when you stop the operation. 

TEMPpoint, VOLTpoint, and MEASURpoint instruments support the following trigger 
sources for starting analog input operations:

• Software trigger – A software trigger event occurs when you start the analog input 
operation (the computer issues a write to the instrument to begin conversions). 

• External digital trigger – An external digital trigger event occurs when the instrument 
detects a voltage from +3 V to +28 V DC on digital input line 0. Initially, the external 
signal must be low and then go high for at least 100 ms to be detected as a trigger. Once 
triggered, the state of digital input 0 is ignored. 

Conversion Modes

TEMPpoint, VOLTpoint, and MEASURpoint instruments support simultaneous single value 
and continuous scan conversion modes for reading input measurements.

This section describes each of these conversion modes.
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Simultaneous Single-Value Operations

If you want a snapshot of all the analog input channels at one point in time, you can perform a 
simultaneous single-value operation, also called a single values operation, using SCPI 
commands. 

Note: This operation mode is supported in SCPI only; it is not supported by the IVI-COM 
driver or the instrument’s web interface.

Use one of the :MEASure SCPI commands to specify the channels that you want to sample 
and the configuration of the channels, if needed. One single value is then acquired from each 
analog input channel simultaneously and returned.

If you need to continuously acquire data from one or more channels use continuous scan 
mode, described next, instead.

Continuous Scan Mode

Continuous scan mode takes full advantage of the capabilities of the TEMPpoint, VOLTpoint, 
and MEASURpoint instruments. Use continuous scan mode if you want to accurately control 
the period between successive simultaneous conversions of specific channels.

In addition to the analog input channels, this conversion mode allows you to read the digital 
input port (all 8 digital input lines) as part of the analog input data stream. This feature is 
particularly useful when you want to correlate the timing of analog and digital events. 

Specifying Analog Input Channels

Using software, enable the analog input channels that you want to sample by specifying the 
channel numbers in the channel list. You can also read the value of the digital input port 
through the analog input data stream by specifying the digital input channel in the channel 
list; the number of the digital input channel depends on how many channels the TEMPpoint, 
VOLTpoint, or MEASURpoint instrument provides, as shown in Table 6.

Table 6: Supported Channels for Continuous Operations

Total Number of
Analog Input Channels

Channel for Reading 
the Digital Input Port

 0 to 7 8

0 to 15 16

0 to 23 24

 0 to 31 32

0 to 39 40

0 to 47 48
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The channels are read in order from the lowest channel number to the highest channel 
number in the list of enabled channels; this process is known as a scan.

How Continuous Scan Works

When you issue a command to start the scan, the instrument simultaneously samples all the 
analog input channels, CJC inputs (if applicable), and the digital input port, and converts the 
analog inputs to temperature, resistance, or voltage based on the sensor type. If the channel is 
enabled, the sampled data is placed in the FIFO on the instrument.

The FIFO on the instrument is used as a circular buffer. Acquisition continues indefinitely 
until you stop the operation. When the FIFO is full, the operation wraps to the beginning of 
the FIFO; values are overwritten starting at the first location in the FIFO. It is up to your 
application to retrieve the data from the FIFO; refer to your software documentation for more 
information.

The conversion rate is determined by the frequency of the input sample clock; refer to page 
105 for more information about the input sample clock. The sample rate, which is the rate at 
which a single entry in the channel list is sampled, is the same as the conversion rate due to 
the simultaneous nature of the MEASURpoint instrument. 

Figure 31 illustrates scanning a list of three enabled channels: channel 0, channel 1, and 
channel 2. In this example, analog input data is acquired simultaneously on each clock pulse 
of the input sample clock. Data is acquired continuously.

Figure 31: Continuous Scan Mode

Filtering

TEMPpoint, VOLTpoint, and MEASURpoint instruments use a Delta-Sigma analog-to-digital 
converter (ADC) for each analog input channel to provide simultaneous sampling of all 
inputs. The Delta-Sigma converter operates at 10 Hz effectively providing a filter that rejects 
50 Hz and 60 Hz power line frequency components and that removes aliasing, a condition 
where high frequency input components erroneously appear as lower frequencies after 
sampling.

In addition to the filter provided in hardware, you can further reduce noise by selecting one of 
the following filter options in software: Moving Average or Raw. Refer to page 81 and to your 
software documentation for more information on selecting a filter type.
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Data Format

TEMPpoint, VOLTpoint, and MEASURpoint instruments return data as 32-bit floating-point 
values. How the data is returned depends on the channel type, as described in the following 
subsections. 

Data Format for Thermocouple Channels

If you specify a thermocouple type of None for a thermocouple input channel, a voltage 
measurement is selected and the instrument returns a voltage value. For the DT8871U and 
DT8874 instruments, the value is in the range of ±0.075 V; for the DT8872 instrument, the 
value is in the range of ±1.25 V. For all other thermocouple types, a temperature value, in 
degrees C, or one of the error constants, described on page 109, is returned.

In normal operation, one floating-point value is returned for each enabled channel (including 
the digital input port). If you enable the capability of returning CJC data in the data stream, 
described on page 101, two floating-point values are returned in the data stream for each 
enabled analog input channel. The first value in the pair represents the temperature (or 
voltage) of the channel; the second value in the pair represents the CJC temperature (in 
degrees C) for that channel.

Data Format for RTD Channels

If you specify an RTD type of None for an RTD input channel, a voltage measurement is 
selected and the instrument returns a voltage value in the range of ±1.25 V. If you specify an 
RTD type of Ohms, a resistance value is returned. For all other RTD types, a temperature 
value, in degrees C, or one of the error constants, described on page 109, is returned.

One floating-point value is returned for each enabled channel (including the digital input 
port).

Data Format for High Voltage Channels

For high voltage channels, a voltage value in the range of ±10 V, ±100 V, or ±400 V is returned, 
depending on how the channel was configured.

One floating-point value is returned for each enabled channel (including the digital input 
port).

Error Conditions

TEMPpoint, VOLTpoint, and MEASURpoint instruments report overrun errors by sending an 
overrun event to the application program. If this error condition occurs, the instrument stops 
acquiring and transferring data to the host computer. To avoid this error, try one or more of 
the following:

• Reduce the sample rate 

• Close any other applications that are running

• Run the program on a faster computer 
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Additionally, the following constants may be reported to the host:

• 99999.0 – SENSOR_IS_OPEN, described on page 101

• 88888.0 – TEMP_OUT_OF_RANGE_HIGH, described on page 103 and page 104

• –88888.0 – TEMP_OUT_OF_RANGE_LOW, described on page 103 and page 104

If any of these constants is reported, the A/D subsystem continues to acquire data; the error 
condition is cleared when the data falls within range.
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Digital I/O Features
TEMPpoint, VOLTpoint, and MEASURpoint instruments provide 8 digital input lines and 8 
digital output lines that you can use to control external equipment, including solid-state or 
mechanical relays. 

This section describes the following digital I/O features:

• Digital input lines, described below

• Digital output lines, described on page 111

• Channel-to-channel isolation, described on page 111

• Resolution, described on page 111

• Operation modes, described on page 111

Digital Input Lines

TEMPpoint, VOLTpoint, and MEASURpoint instruments feature eight, isolated, digital input 
lines.

Digital inputs operate from +3 to +28 V DC, with a switching time of 2 ms maximum. Figure 
32 shows the digital input circuitry; a 2.2 kΩ resistor is used in series with the LED in the 
opto-isolator input.

Figure 32: Digital Input Circuitry

A digital line is high (switch is closed) if its value is 1; a digital line is low (switch is open) if its 
value is 0. 
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Digital Output Lines

TEMPpoint, VOLTpoint, and MEASURpoint instruments feature eight, latched and isolated 
digital output lines. The outputs are solid-state relays that operate at ±30 V and 400 mA peak 
(AC or DC). Switching time is 2 ms maximum. 

Figure 33 shows the digital output circuitry.

Figure 33: Digital Output Circuitry

Digital outputs resemble a switch; the switch is closed if the state of the digital output line is 1, 
and the switch is open if the state of the digital output line is 0. On power up or reset, the 
digital outputs are disabled. 

Channel-to-Channel Isolation

Each TEMPpoint, VOLTpoint, and MEASURpoint instrument includes channel-to-channel 
isolation of up to 250 V between digital I/O lines. If you require greater channel-to-channel 
isolation, use every other digital line. This reduces the number of digital I/O lines, but 
provides channel-to-channel isolation of 500 V (one channel can be +250 V while the adjacent 
channel can be –250 V).

Resolution

Each TEMPpoint, VOLTpoint, and MEASURpoint instrument provides 8 bits of resolution for 
the digital input port to accommodate the 8 digital input lines and 8 bits of resolution for the 
digital output port to accommodate the 8 digital output lines. These lines are organized as 
isolated, dedicated ports. You cannot configure port resolution through software. 

Operation Modes

Using software, you can read from a single digital input line or the entire digital input port, or 
write to a single digital output line or the entire digital output port. You can also return the 
value of the entire digital input port in the analog input data stream if you want to correlate 
analog input data with digital events; refer to page 105 for more information. 
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General Checklist 
Should you experience problems using a TEMPpoint, VOLTpoint, or MEASURpoint 
instrument, do the following: 

1. Read all the documentation provided for your product. Make sure that you have added 
any “Read This First” information to your manual and that you have used this 
information.

2. Check the Instrument OMNI CD for any README files and ensure that you have used 
the latest installation and configuration information available.

3. Check that your system meets the requirements stated in Chapter 2.

4. Check that you have installed your hardware properly using the instructions in Chapter 3.

5. Check that you have wired your signals properly using the instructions in Chapter 4. 

6. Check that you have installed Java and configured your web browser appropriately using 
the instructions on page 67.

7. Search the DT Knowledgebase in the Support section of the Data Translation web site (at 
www.datatranslation.com) for an answer to your problem.

If you still experience problems, try using the information in Table 7 to isolate and solve the 
problem. If you cannot identify the problem, refer to page 116. 

Table 7: Troubleshooting Problems 

Symptom Possible Cause Possible Solution

Instrument is 
not found.

The instrument cannot 
communicate with the 
network. 

Ensure that your instrument is properly connected; see the 
instructions in Chapter 3.

If your PC has a static IP address, reconfigure it for Auto-IP using 
the instructions on page 154.

Check your LAN configuration; see the instructions on page 78.

Check the IP address of the instrument by opening a Command 
Prompt window (Start -> Programs -> Accessories -> Command 
Prompt) and entering the command 
"ipconfig /all". The IP settings of your instrument are returned.

Ping the instrument by opening a Command Prompt window 
(Start -> Programs -> Accessories -> Command Prompt) and 
entering the command "ping address", where address is the IP 
address of your instrument. If a timeout message is returned, the 
IP address is incorrect. If a "no host" error message is returned, 
the subnet mask is incorrect. Refer to page 42 for more 
information on IP and subnet addresses.

If needed, reset the instrument using the instructions on page 44.



Troubleshooting
Instrument 
does not 
respond.

The instrument configuration 
is incorrect.

Check your LAN configuration; see the instructions on page 78.

Check the IP address of the instrument by opening a Command 
Prompt window (Start -> Programs -> Accessories -> Command 
Prompt) and entering the command "ipconfig /all". The IP settings 
of your instrument are returned.

Ping the instrument by opening a Command Prompt window 
(Start -> Programs -> Accessories -> Command Prompt) and 
entering the command "ping address", where address is the IP 
address of your instrument. If a timeout message is returned, the 
IP address is incorrect. If a "no host" error message is returned, 
the subnet mask is incorrect. Refer to page 42 for more 
information on IP and subnet addresses.

If needed, reset the instrument using the instructions on page 44.

The instrument is damaged. Contact Data Translation for technical support; refer to page 116.

Intermittent 
operation.

Loose connections or 
vibrations exist.

Check your wiring and tighten any loose connections or cushion 
vibration sources; see the instructions in Chapter 4.

The instrument is 
overheating.

Check environmental and ambient temperature; consult the 
specifications on page 132 of this manual and the documentation 
provided by your computer manufacturer for more information.

Electrical noise exists. Check your wiring and either provide better shielding or reroute 
unshielded wiring; see the instructions in Chapter 4.

Data appears 
to be invalid.

An open connection exists. Check your wiring and fix any open connections; see the 
instructions in Chapter 4.

A transducer is not connected 
to the channel being read.

Check the transducer connections; see the instructions in 
Chapter 4.

The thermocouple, RTD, or 
voltage input that you 
connected to the channel 
does not match the software 
configuration for that channel.

Check your wiring and ensure that what you specify in software 
matches your hardware configuration; see the instructions in 
Chapter 4.

Your instrument may need 
recalibration. 

The instrument is calibrated at the factory. Thereafter, yearly 
calibration is recommended. Use the Measurement Instrument 
Calibration Utility, described on page 21, or return your instrument 
to Data Translation for recalibration. 

For information on factory recalibration, contact Data Translation 
at 508-481-3700, ext. 1323 (if you are in the USA) of call your 
local distributor (if you are located outside the USA); see our web 
site (www.datatranslation.com) for the name and telephone 
number of your nearest distributor.

Table 7: Troubleshooting Problems  (cont.)

Symptom Possible Cause Possible Solution
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Technical Support 
If you have difficulty using your TEMPpoint, VOLTpoint, or MEASURpoint instrument, Data 
Translation’s Technical Support Department is available to provide technical assistance. 

To request technical support, go to our web site at http://www.datatranslation.com and click 
on the Support link. 

When requesting technical support, be prepared to provide the following information:

• Your product serial number 

• The hardware/software product you need help on 

• The version of the Instrument OMNI CD you are using 

• Your contract number, if applicable 

If you are located outside the USA, contact your local distributor; see our web site 
(www.datatranslation.com) for the name and telephone number of your nearest distributor.



Troubleshooting
If Your Instrument Needs Factory Service 
If your TEMPpoint, VOLTpoint, or MEASURpoint instrument must be returned to Data 
Translation, do the following: 

1. Record the instrument’s serial number, and then contact the Customer Service 
Department at (508) 481-3700, ext. 1323 (if you are in the USA) and obtain a Return 
Material Authorization (RMA).

If you are located outside the USA, call your local distributor for authorization and 
shipping instructions; see our web site (www.datatranslation.com) for the name and 
telephone number of your nearest distributor. All return shipments to Data Translation 
must be marked with the correct RMA number to ensure proper processing.

2. Using the original packing materials, if available, package the instrument as follows:

− Wrap the instrument in an electrically conductive plastic material. Handle with 
ground protection. A static discharge can destroy components on the instrument.

− Place in a secure shipping container. 

3. Return the instrument to the following address, making sure the RMA number is visible 
on the outside of the box.

Customer Service Dept.
Data Translation, Inc.
100 Locke Drive
Marlboro, MA 01752-1192
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Basic Instrument Specifications
Table 8 lists the basic instrument specifications for TEMPpoint, VOLTpoint, and 
MEASURpoint instruments. 

Table 8: Basic Instrument Specifications 

Feature Specifications

Number of channels in channel list Up to 48 analog input channels and one digital input 
port

A/D converter type 24-bit Sigma-Delta



Specifications
Thermocouple Specifications
Table 9 lists the thermocouple specifications for thermocouple channels on the TEMPpoint 
and MEASURpoint instruments.

System Temperature Error for the DT8871U and DT8874

Table 10 lists the accuracy of the DT8871U and DT8874 for each thermocouple type at several 
temperature points over the dynamic range of the instrument.

Table 9: Thermocouple Specifications

Feature Specifications

Thermocouple types (software-selectable) B, E, J, K, N, R, S, T

A/D resolution 24-bits

Sample rate 10 Samples/s

Thermal disturbance channel-to-channel None

Upscale break detection current
DT8871U and DT8874:
DT8871:

+10 nA
+100 nA

System temperature error
DT8871U and DT8874:
DT8871:

See Table 10 on page 121
See Table 11 on page 123

Table 10: Calculated Thermocouple Accuracy of the DT8871U and DT8874

Input
Temp.

Thermocouple Typea

a. Conditions for accuracy measurements:
Warm-up time of 45 minutes. Inclusive of typical 0.15° C CJC error (maximum CJC error is 0.25° C).
Inclusive of typical 0.25 μV offset error (maximum offset error is 2.5 μV). Exclusive of thermocouple errors.
Exclusive of noise (see Figure 34 and Figure 35 for more information about system noise).

J K T E S R B N

–100°  C ±0.17° C ±0.17° C ±0.16° C ±0.16° C ----------- ----------- ----------- ±0.16° C

0°  C ±0.15° C ±0.16° C ±0.16° C ±0.15° C ±0.2° C ±0.2° C ----------- ±0.16° C

100°  C ±0.18° C ±0.15° C ±0.16° C ±0.15° C ±0.18° C ±0.18° C ----------- ±0.15° C

300°  C ±0.15° C ±0.17° C ±0.16° C ±0.15° C ±0.18° C ±0.18° C ±0.23° C ±0.15° C

500°  C ±0.15° C ±0.15° C ----------- ±0.15° C ±0.18° C ±0.17° C ±0.21° C ±0.15° C

700°  C ±0.15° C ±0.15° C ----------- ±0.16° C ±0.18° C ±0.18° C ±0.17° C ±0.16° C

900°  C ±0.15° C ±0.17° C ----------- ±0.17° C ±0.18° C ±0.18° C ±0.19° C ±0.16° C

1100°  C ±0.15° C ±0.16° C ----------- ----------- ±0.19° C ±0.18° C ±0.18° C ±0.16° C

1400°  C ----------- ----------- ----------- ----------- ±0.18° C ±0.18° C ±0.17° C -----------
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The histograms shown in Figure 34 and Figure 35 characterize the Gaussian system noise 
distribution for each of the available filter types on the DT8871U and DT8874. Note that 
converting μV error to temperature error depends on thermocouple type. For example, a K 
thermocouple changes approximately 39 μV per degrees C; therefore, a noise level of 0.1 μV 
adds less than 0.003° C error (0.1 μV / 39 μV) for a type K thermocouple.

Figure 34: System Noise on the DT8871U and DT8874 Using No Software Filter (Raw Filter)

Figure 35: System Noise on the DT8871U and DT8874 Using the Moving Average Filter



Specifications
System Temperature Error for the DT8871

Table 11 lists the accuracy of the DT8871 for each thermocouple type at several temperature 
points over the dynamic range of the instrument.

 

The histograms shown in Figure 36 and Figure 37 characterize the Gaussian system noise 
distribution for each of the available filter types on the DT8871. Note that converting μV error 
to temperature error depends on thermocouple type. For example, a K thermocouple changes 
approximately 39 μV per degrees C; therefore, a noise level of 10 μV adds 0.3° C error (10 μV / 
39 μV) for a type K thermocouple.

Table 11: Calculated Thermocouple Accuracy of the DT8871 

Input
Temperature

Thermocouple Typea

a. Conditions for accuracy measurements:
Warm-up time of 45 minutes. Inclusive of typical 0.2° C CJC error (maximum CJC error is 0.3° C).
Inclusive of typical 5 μV offset error (maximum offset error is 50 μV). Exclusive of thermocouple errors.
Exclusive of noise (see Figure 36 and Figure 37 for more information about system noise).

J K T E S R B N

–100°  C ±0.33° C ±0.37° C ±0.38° C ±0.31° C ----------- ----------- ----------- ±0.44° C

0°  C ±0.3° C ±0.33° C ±0.33° C ±0.28° C ±1.12° C ±1.14° C ----------- ±0.39° C

100°  C ±0.31° C ±0.29° C ±0.31° C ±0.27° C ±0.88° C ±0.86° C ----------- ±0.35° C

300°  C ±0.29° C ±0.34° C ±0.29° C ±0.26° C ±0.75° C ±0.71° C ±1.84° C ±0.33° C

500°  C ±0.28° C ±0.31° C ----------- ±0.26° C ±0.71° C ±0.66° C ±1.2° C ±0.33° C

700°  C ±0.27° C ±0.3° C ----------- ±0.27° C ±0.68° C ±0.63° C ±0.92° C ±0.33° C

900°  C ±0.27° C ±0.34° C ----------- ±0.28° C ±0.66° C ±0.6° C ±0.8° C ±0.33° C

1100°  C ±0.28° C ±0.34° C ----------- ----------- ±0.64° C ±0.58° C ±0.71° C ±0.34° C

1400°  C ----------- ----------- ----------- ----------- ±0.62° C ±0.56° C ±0.64° C -----------
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Figure 36: System Noise on the DT8871 Using No Software Filter (Raw Filter)

Figure 37: System Noise on the DT8871 Using the Moving Average Filter



Specifications
RTD Specifications 
Table 12 lists the specifications for RTD channels on the TEMPpoint and MEASURpoint 
instruments.

Table 13 lists the RTD alpha curves that are supported by RTD channels.

Table 12: RTD Specifications 

Feature Specifications

RTD types (software-selectable) Platinum 100 Ω, 500 Ω, and 1000 Ω 

A/D converter resolution 24-bits

Sample rate 10 Samples/s 

Supported temperature range –200 to +850°  C (European standard)

Current source
Absolute current:

Drift:

Drift per year:

425 μA, ±0.5% at 25°  C (calibrated in firmware)

10 ppm/°  C maximum

± 100 ppm typical 

Internal reference +1.250 ±0.002 V

Thermal disturbance channel-to-channel None

Supported RTD alpha curves See Table 13 on page 125

Table 13: Supported RTD Alpha Curves

Alpha (Average 
Temperature 
Coefficient of 

Resistance (/° C))

Nominal 
Resistance at 

0° C Organization Standard

0.00385 100 Ω British Standard BS1904: 1984

Deutschen Institut 
fur Normung

DIN 43760: 1980

0.00392 98.129 Ω Scientific Appartus 
Manufacturers of 
America

SAMA 
RC-4-1966
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Isolation and Protection Specifications
Table 14 lists the isolation and protection specifications for the analog input subsystem on the 
TEMPpoint, VOLTpoint, and MEASURpoint instruments.

Table 14: Isolation and Protection Specifications 

Feature Specifications

Overvoltage protection (power on/off)
DT8871U, DT8871, and DT8874 thermocouple channels:
DT8872 and DT8874 RTD channels:
DT8873 and DT8874 high voltage channels:

±40 V
±40 V
±500 V

ESD protection 
Arc:
Contact:

8 kV
4 kV

Isolation voltage to the host computer ±500 V

Channel-to-channel isolation ±500 V



Specifications
Memory Specifications
Table 15 lists the memory specifications for the analog input subsystem on TEMPpoint, 
VOLTpoint, and MEASURpoint instruments.

Table 15: Memory Specifications

Feature Specifications

Data memory onboard 4 MByte

For Data logger built in, maximum time
before old data is overwrittena

48 channels @ 10 Hz:
48 channels @ 1 Hz:
48 channels @ 0.1 Hz:

a. Assumes limit detection is off for all channels, and for thermocouple channels, 
assumes CJC data is not collected. If power fails, all temperature data in the 
system is lost. The channel input type and filter settings are still available after 
power on, but the channel and digital I/O labels and channel limits are lost.

30 minutes
5 hours
50 hours
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Temperature Stability Specifications
Table 16 lists the temperature stability specifications for thermocouple channels on the 
TEMPpoint and MEASURpoint instruments.

Table 17 lists the temperature stability specifications for RTD channels on the TEMPpoint and 
MEASURpoint instruments.

Table 16: Temperature Stability Specifications for Thermocouple Channels

Feature Specifications

Additional error due to ambient temperature 
changea

J-type thermocouple:
K-type thermocouple:
B-type thermocouple:
E-type thermocouple:
N-type thermocouple:
R-type thermocouple:
S-type thermocouple:
T-type thermocouple:

a. Includes the A/D reference, gain, and CJC errors.

0.010°  C per degree ambient change, typical
0.011°  C per degree ambient change, typical
0.014°  C per degree ambient change, typical
0.010°  C per degree ambient change, typical
0.011°  C per degree ambient change, typical
0.012°  C per degree ambient change, typical
0.012°  C per degree ambient change, typical
0.010°  C per degree ambient change, typical

Warm-up time 45 minutes

CJC
Error:

Accuracy:

Drift per year:

±0.2°  C

Corrected in ROM @ 25°  C to zero error

±50 ppm typical

Table 17: Temperature Stability Specifications for RTD Channels

Feature Specifications

System temperature errora

Pt100:
Pt500:
Pt1000:

a. The system temperature error is based on the auto zero and system noise error (±0.07°  C for a 
Pt100 RTD, ±0.01°  C for a Pt500 RTD, or ±0.007°  C for a Pt1000 RTD) plus the gain error of the 
A/D and output impedance of the current source over the voltage range (±0.005% of the 
reading). For example, the maximum error of a Pt100 RTD at 100°  C is ±0.075°  C (±0.07° C plus 
a gain error of ±0.005°  C).

±0.07° C, ±0.005% of reading
±0.01° C, ±0.005% of reading
±0.007° C, ±0.005% of reading

Temperature resolution ±0.0003°  C (based on a European 
PT1000 RTD)

Warm-up time 1 minute



Specifications
Voltage Measurement Specifications
Table 18 lists the voltage measurement specifications for the TEMPpoint, VOLTpoint, and 
MEASURpoint instruments.

Table 18: Voltage Measurement Specifications 

Feature Specifications

Input voltage range (no compensation)
DT8871U and DT8874 thermocouple channels:
DT8871:
DT8872 and DT8874 RTD channels:
DT8873 and DT8874 high voltage channels:

±0.0750 V
±1.2500 V
±1.2500 V
±10 V, ±100 V, or ±400 Va

A/D converter resolution 24-bits

Voltage resolution
DT8871U and DT8874 thermocouple channels:
DT8871:
DT8872 and DT8874 RTD channels:
DT8873 and DT8874 high voltage channels:

0.015 μV
0.3 μV
0.3 μV
1.2 μV for the ±10 V input range;
12 μV for the ±100 V input range;
48 μV for the ±400 V input range

Sample rate 10 Samples/s

Gain 1

Input impedance
DT8871U and DT8874 thermocouple channels:
DT8871:
DT8872 and DT8874 RTD channels:
DT8873 and DT8874 high voltage channels:

5 MΩ typical
5 MΩ typical
> 100 MΩ 
> 1 MΩ (Power ON or OFF)

Input common mode voltage ±500 V

Common mode rejection @ 60 Hz and 50 Hz > 150 dB

Coupling DC

System linearity
DT8871U and DT8874 thermocouple channels:
DT8871:
DT8872 and DT8874 RTD channels:
DT8873 and DT8874 high voltage channels:

±0.005%
±0.005%
±0.001%
±0.001%

System gain error (includes all noise sources; gain = 1)
DT8871U and DT8874 thermocouple channels:
DT8871:
DT8872 and DT8874 RTD channels:
DT8873 and DT8874 high voltage channels:

±0.00075% of full-scale range
±0.00075% of full-scale range
±0.00075% of full-scale range
±0.01% of reading

System zero error (includes all noise sources; 
gain = 1; no filter)
DT8871U and DT8874 thermocouple channels:
DT8871:
DT8872 and DT8874 RTD channels:
DT8873 and DT8874 high voltage channels:

0.25 μV RMS
5 μV RMS
±12 μV 
±300 μV for the ±10 V input range;
±2 mV for the ±100 V input range;
±8 mV for the ±400 V input range
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System drift error, zero
DT8871U and DT8874 thermocouple channels:
DT8871:
DT8872 and DT8874 RTD channels:
DT8873 and DT8874 high voltage channels:

±0.02 μV/°  C typical
±0.02 μV/°  C typical
±0.10 μV/°  C
±0.5 μV/°  C for the ±10 V input range;
±5 μV/°  C for the ±100 V input range;
±20 μV/°  C for the ±400 V input range

System drift error, gain
DT8871U and DT8874 thermocouple channels:
DT8871:
DT8872 and DT8874 RTD channels:
DT8873 and DT8874 high voltage channels:

±4 ppm/°  C
±4 ppm/°  C
±10 ppm/°  C
±15 ppm/°  C

A/D reference 
Drift:
Drift per year:

±8 ppm/°  C maximum
±100 ppm typical

Full-scale long-term stability
DT8871U and DT8874 thermocouple channels:

DT8871:

DT8872 and DT8874 RTD channels:

DT8873 and DT8874 high voltage channels:

±100 ppm/year typical

±100 ppm/year typical

±0.05°  C per year @ 0°  C (±0.27°  C 
per year @ full-scale temperature)

±100 ppm/year typical

Warm-up time for the DT8873 and DT8874 high 
voltage channels: 1 hour

a. You configure the input range for each channel using software.

Table 18: Voltage Measurement Specifications  (cont.)

Feature Specifications



Specifications
Digital I/O Specifications
Table 19 lists the specifications for the digital input (DIN) and digital output (DOUT) 
subsystems on the TEMPpoint, VOLTpoint, and MEASURpoint instruments. 

Table 19: Digital I/O Specifications 

Feature Specifications

Number of digital I/O lines 16 (8 In, 8 Out)

Number of ports 2, 8-bit (1 In, 1 Out)

Inputs 
Input type: 
High input voltage: 
Low input voltage: 
High input current: 
Low input current: 
Termination 

DC
+3 to +28 V 
< +1.5 V
2.2 kΩ resistor to 1.2 V 
2.2 kΩ resistor to 1.2 V 
Series 2.2 kΩ 

Outputs 
Output type: 
Output driver: 
High output: 
Low output: 
Breakdown voltage: 
Contact impedance: 

Solid-state relay 
CMOS 
± 30 V 
0.4 V @ 400 mA 
± 60 V 
1 Ω 

Isolation voltage 
To computer ground: 
Channel to channel 

±500 V
±250 Va

a. Determined by the pin spacing in the 37-pin digital connector. For greater 
channel-to-channel isolation, use every other digital I/O line; using every 
other digital I/O line allows ±500 V isolation channel-to-channel.
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Power, Physical, and Environmental Specifications 
Table 20 lists the power, physical, and environmental specifications for the TEMPpoint, 
VOLTpoint, and MEASURpoint instruments.

Table 20: Power, Physical, and Environmental Specifications 

Feature Specifications

External power requirements +5 V ±0.25V @ 2 A (0.9 mA typical)

Physical
Dimensions of enclosure:

Weight: 

88.14 (H) x 212.85 mm (W) x 
211.43 mm (D)

1704 g 

Environmental
Operating temperature range:
Storage temperature range:
Relative humidity: 
Altitude:

0°  C to 55°  C
–25°  C to 85°  C
to 95%, noncondensing
up to 10,000 feet



Specifications
Regulatory Specifications
Table 21 lists the regulatory specifications for the TEMPpoint, VOLTpoint, and MEASURpoint 
instruments.

Table 21: Regulatory Specifications 

Feature Specifications

Emissions (EMI) FCC Part 15, 
EN55022:1994 + A1:1995 + A2:1997
VCCI, AS/NZS 3548
Class A

Immunity EN61000-6-1:2001

RoHS (EU Directive 2002/95/EG) Compliant (as of July 1st, 2006)

Aerospace Material Specification Compliant with AMS2750D
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Connector Specifications
This section lists the specifications for the following connector types:

• Thermocouple connectors

• RTD connectors

• High voltage connectors

• Ethernet connector

Thermocouple Connectors

Table 22 lists the specifications for the thermocouple connectors used on the TEMPpoint and 
MEASURpoint instruments.

RTD Connectors 

Table 23 lists the specifications for the RTD connectors used on the TEMPpoint and 
MEASURpoint instruments.

High Voltage Connectors

Table 24 lists the specifications for the high voltage connectors used on the VOLTpoint and 
MEASURpoint instruments.

Table 22: Thermocouple Connector Specifications 

Feature Specifications

Thermocouple jacks Cu-Cu Omega plugs (White SMPW-U-M)

Thermocouple connector Omega part# PCC-SMP-U-100-R-CE-ROHS

Table 23: RTD Connector Specifications 

Feature Specifications

4-Position screw terminal block header Phoenix Contact 1803293 

4-Position screw terminal block plug Phoenix Contact 1803594

Table 24: Voltage Connector Specifications 

Feature Specifications

4-Position screw terminal block header Phoenix Contact 1803293 

4-Position screw terminal block plug Phoenix Contact 1803594



Specifications
Ethernet (RJ45) Connector

The Ethernet (RJ45) connector used on the TEMPpoint, VOLTpoint, and MEASURpoint 
instruments is shown in Figure 38.

Figure 38: Ethernet (RJ45) Connector

The pin assignments of this connector are described in Table 25:

Note: TEMPpoint, VOLTpoint, and MEASURpoint instruments do not support 
Auto-MDIX.

Table 25: Ethernet Connector Pin Assignments 

Pin Signal Name Description

1 TXD+ Transmit Data+

2 TXD− Transmit Data−

3 RXD+ Receive Data+

4 EPWR+ Power from Switch+

5 EPWR+ Power from Switch+

6 RXD− Receive Data−

7 EPWR− Power from Switch−

8 EPWR− Power from Switch−
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Connector Pin Assignments
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Table 26 lists the pin assignments for the 37-pin digital I/O connector on TEMPpoint, 
VOLTpoint, and MEASURpoint instruments.

Table 26: Digital I/O Connector Pin Assignments

Pin Description Pin Description

1 Digital Input 0+ –

2 Digital Input 1+ 20 Digital Input 0–

3 Digital Input 2+ 21 Digital Input 1–

4 Digital Input 3+ 22 Digital Input 2–

5 Digital Input 4+ 23 Digital Input 3–

6 Digital Input 5+ 24 Digital Input 4–

7 Digital Input 6+ 25 Digital Input 5–

8 Digital Input 7+ 26 Digital Input 6–

9  Not Connected 27 Digital Input 7–

10 Digital Output 0 28 Not Connected

11 Digital Output 1 29 Digital Output 0

12 Digital Output 2 30 Digital Output 1

13 Digital Output 3 31 Digital Output 2

14 Digital Output 4 32 Digital Output 3

15 Digital Output 5 33 Digital Output 4

16 Digital Output 6 34 Digital Output 5

17 Digital Output 7 35 Digital Output 6

18 Not Connected 36 Digital Output 7

19 Not Connected 37 Not Connected
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Overview
In addition to the web interface, described in Chapter 5, you can verify the operation of your 
TEMPpoint, VOLTpoint, or MEASURpoint instrument using the Measurement Application 
that is provided with the instrument. The Measurement Application, developed using 
Measure Foundry, lets you perform the following functions:

• Configure your instrument 

• Acquire temperature, resistance, and/or voltage data from up to 48 analog input channels

• Display temperature, resistance, and/or voltage data during acquisition

• Use a Chart Recorder to display and log data to an.hpf file for later analysis 

• View any .hpf file, and view the last recorded .hpf data file in Microsoft Excel®

• Set minimum and maximum alarm limits for each channel

• Set the state of the digital output lines based on alarm limits 

• Read the state of the digital input port

If desired, you can use Measure Foundry to customize this application.

Refer to page 31 for information on installing the Measurement Application.



Using the Measurement Application
Running the Measurement Application
To run the Measurement Application, perform the following steps:

1. Click Start -> Programs -> Data Translation, Inc -> Measurement -> Measurement 
Application
The Device Selection screen is displayed:

2. By default, the application "discovers" all TEMPpoint, VOLTpoint, and MEASURpoint 
instruments that are available and displays them in the list of Available Instruments. If 
you want to refresh this list to determine if other TEMPpoint, VOLTpoint, or 
MEASURpoint instruments are available, click Refresh list.

3. If your instrument is included in the list of Available Instruments and you want to 
connect to it, select the connect string for the instrument that you want to use from the list 
of Available Instruments, and then go to step 6.
Information about the instrument, including the scanning status, model number, firmware 
version, and serial number, is displayed.

4. If you do not have a TEMPpoint, VOLTpoint, or MEASURpoint instrument connected or 
if you want to simulate the operation of an instrument, click one of the following 
selections, and then go to step 6:

− Device Simulation Mode - MEASURpoint – Simulates the operation of a 
MEASURpoint instrument.

− Device Simulation Mode - VOLTpoint – Simulates the operation of a VOLTpoint 
instrument.

− Device Simulation Mode - TEMPpoint RTD – Simulates the operation of a DT9872 or 
DT8872 TEMPpoint instrument.
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− Device Simulation Mode - TEMPpoint TC – Simulates the operation of a DT9871, 
DT9871U, DT8871, or DT8871U TEMPpoint instrument.
When selected, the button indicator turns green. 

5. If your instrument is not included in the list of Available instruments, but you want to 
manually connect to it, do the following:

a. Click Advanced.
The following screen is displayed:

b. Determine the IP address of your instrument on the TCP/IP network using an LXI 
discovery tool, such as the Eureka Discovery Utility provided with your instrument, 
see page 72 for information on using this utility.

c. Enter the VISA Connect String for your instrument (such as 
TCPIP::192.43.218.69::INSTR or TCPIP::192.43.218.44::SOCKET), and click Set. 

d. If you want to simulate the operation of an instrument, enter the string 
simulate=true,model=xxxxxx in the VISA Option String text box and click Set, where 
xxxxxx is the model number of the instrument you want to simulate (DT9871, DT8871, 
DT9872, and DT8872 for TEMPpoint instruments, DT9873 and DT8873 for VOLTpoint 
instruments, and DT987x and DT887x for MEASURpoint instruments).

6. (Optional) If you previously used the Measurement Application, and you want to 
overwrite the configuration of the last session (which was automatically saved) with the 
default configuration for the selected instrument, click the Reset to Default Config 
button. 

7. (Optional) If you previously used the Measurement Application, and you want to 
overwrite the names of the channels (which were automatically saved) with the default 
channel names for the selected instrument, click the Reset Channel Names button. Note 
that this step is useful especially when changing between instrument types.

8. Click Continue.
The latest state is saved and used when the application is next run, and the Channel Overview 
screen of the Measurement Application is displayed. Note that data acquisition is started 
automatically and temperature values are displayed (in degrees C), by default. 



Using the Measurement Application
Figure 39: Channel Overview Screen of the Measurement Application

Note that the Channel Type field on the left of the screen indicates the type of sensor that is 
used for the corresponding row of measurement values. For example,

• TC represents the values for thermocouple channels

• RTD represents the values for RTD channels

• Volts represents the values for voltage input channels with an input range of ±10 V
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Changing the Configuration of Your Instrument
To change the configuration of your instrument, follow these steps:

1. Stop acquisition by clicking the Start/Stop button from the main window or by clicking 
Stop Acquisition from the Acquisition menu.

2. Click the Configuration menu, and then click Change Configuration.
The Change Configuration screen is displayed:

3. Under Unit, select the temperature units in which to display temperature data: ° C 
(Celsius), ° F (Fahrenheit), or ° K (Kelvin).

4. Under Sensor Type, select the input type for each of the channels.

For channels that support programmable voltage ranges, the following drop-down box is 
displayed; select the voltage range that you want to uses for the channel:

Note: If you want to set all the channels to the same configuration at once, select the 
configuration to apply using the Set all to combo box.

If you select a voltage sensor type for a channel, the data is displayed in voltage. The 
sensor type setting is ignored for the digital input port.
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5. Under Filter Type, select Moving Average if you want to filter the data or Raw if you do not 
want to filter the data.

6. Under Log Channels to Disk, check the channels that you want to log to disk when you 
use the Chart Recorder (described on page 148). The first time you use the Measurement 
Application, all channels are selected for data logging.

7. Under External Trigger Enable, select True if you want to start acquisition using an 
external trigger signal connected to digital input line 0; otherwise, select False.

8. Under Channel Names, specify a meaningful name to represent each channel.

9. Under Acquisition Frequency, click the frequency (10 Hz, 5 Hz, 2 Hz, Every 2 s, Every 5 
s, Every 10 s, Every Minute, Every 2 Minutes, Every 5 Minutes) at which to 
simultaneously sample all channels.

10. When you are finished configuring the Measurement Application, click OK. 

11. To save the configuration settings, click the Configuration menu, and then click Save 
Configuration File.

12. Enter a name for the configuration file, select the directory in which to save the file, and 
then click Save.
This file has the extension (*.Measurement).

Note: You can save numerous configuration settings, if desired. To load a previously 
saved configuration, click the Configuration menu, and then click Load Configuration 
File.

13. Restart acquisition by clicking Start Acquisition from the Acquisition menu or by 
clicking Start/Stop from the main window.
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Defining Alarm Limits
When you start the Measurement Application for the first time, the following alarm limits are 
defined for each channel:

• Minimum alarm limit = 0

• Maximum alarm limit = 100

If the acquired value for a channel is between the defined minimum and maximum alarm 
limits, the value is within range and is displayed in black. If the acquired value for a channel is 
below the minimum or above the maximum alarm limit, the value is out of range and is 
displayed in red.

To change the alarm limits, do the following:

1. From the Windows menu, select Limit Definition.
A screen similar to the following is displayed:

2. If you want to change the minimum alarm limit for a channel, enter a value in the Min 
field for that channel, and then click Set next to the value that you entered.

3. If you want to change the maximum alarm limit for a channel, enter a value in the Max 
field for that channel, and then click Set next to the value that you entered.

4. If you want to set a digital output line when the alarm limits for a channel are exceeded, 
click the Open Digital Output Definition Window button from the Limit Definition 
screen.
The following screen appears:
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5. For each channel, select the digital output line (bit) that you want to turn on when the 
limits for a channel are exceeded. If you do not want to set a digital output line when the 
alarm limits are exceeded, choose none.

Note: You can assign the same digital output line to multiple channels. The digital 
output line is turned on (1) when any of the alarm limits are exceeded on the channels that 
were assigned to that digital output line.

If alarm limits are not exceeded, the digital output line is turned off (0).

6. To see the state of the digital output lines, click the OUT button from main window, or 
from the Windows menu, select Digital Output Panel. 
A screen similar to the following appears:
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Logging Data to Disk
To log data to disk, perform the following steps:

1. Ensure that you configured the channels that you want to log to disk (see page 145).

2. Start acquisition by clicking the Start/Stop button from the main window or, from the 
Acquisition menu, by selecting Start Acquisition.

3. Click the Chart Recorder button on the main window, or from the Windows menu, select 
Chart Recorder.
A screen similar to the following appears:

4. Under Channel Visibility, select the channels that you want to be visible on the display.

Note: The first time that you run the Measurement Application, all the channels are 
visible.

5. From the Time Axis Length drop-down list, select the time (10 Seconds, 1 Minute, 5 
Minutes, 10 Minutes, 30 Minutes, 1 Hour, 2 Hours, 4 Hours) to use for the time axis.

6. If you want to display all the data on a single band, leave the Single Band/Multiple Band 
button untouched (the button indicator is green).

If you want to display the data for each channel on a separate band, click the Single 
Band/Multiple Band button so that the button indicator turns gray.
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7. To begin recording data, click the Start Recording button.
You are prompted to name the file in which to store the recorded data. The data file has an .hpf 
extension.

8. Enter a name for the data file, and then click Save.
The data for each channel is then displayed on the screen and logged to disk:

9. When you have finished recording, click the Stop Recording button.

10. If you want to view this data in Microsoft Excel, click the button called Open Last 
Recording in Excel.

Note: The Chart Recorder has other features, such as scrolling, autoscaling, printing, and so 
on. Refer to the online help provided with the Measurement Application for more 
information on these features.
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Viewing a Data File
To view the data that you recorded in an .hpf file with the Chart Recorder, perform the 
following steps:

1. Click the Load Data File button from the main window, or from the File menu, select 
Load Data File.
You are prompted to select the name of the data file to view.

2. Select the name of the data file to view, and then click Open.
The data file is displayed in the File Viewer window.

3. You can then scroll through the data, change the scale of the display, print the data, and 
so on. Refer to the online help provided with the Measurement Application for more 
information about these features.

4. When you are finished viewing the data file, click Close.
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Reading Digital Input Values
To read the state of the digital input port, perform the following steps:

1. Click the Digital In button from the main window, or from the Windows menu, select 
Digital Input Panel, 
A screen similar to the following appears:

Note: The LED indicator turns green when a value of 1 is detected on the digital input 
line and turns gray when a value of 0 is detected on the digital input line.
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Exiting from the Measurement Application
When you finished using the Measurement Application, exit from the application by selecting 
the File menu and clicking Quit.
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Configuring the PC to Use Auto-IP
To set up the a TEMPpoint, VOLTpoint, or MEASURpoint instrument when the LAN does not 
support a DHCP server and your PC is configured to use a static IP address, you must 
temporarily reconfigure the PC to use Auto-IP by performing the following steps:

Note: This procedure may differ slightly depending on your computer and the version of 
Windows you are using. Windows XP instructions are shown here.

1. From the Windows Start menu, click Settings, and then click Network Connections.

2. Right-click Local Area Connection, and select Properties.

3. In the General tab window, double-click Internet protocol (TCP/IP). (If a TCP/IP 
selection is not listed, click Install, select Protocol, click Add, select the TCP/IP protocol, 
and click Install, and repeat step 3).
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4. IMPORTANT: Write down the IP address and subnet mask that is displayed! You will 
need this information later.

5. Select Obtain an IP address automatically, and then click OK.

6. Select the Alternate Configuration tab, and ensure that Automatic private IP address is 
selected.
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7. Renew the IP address of the computer. From the Windows Start menu, click Settings 
->Network Connections -> Local Area Connection -> Support -> Repair. 

Or, if you prefer to do this from the command prompt window, click Run from the 
Windows Start menu, enter cmd, and click OK to bring up the command prompt 
window. Then, from the command prompt window, enter:

ipconfig /renew renews the IP address
ipconfig /all checks the IP address
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Specifying a Static IP Address for your Instrument
To specify a static IP address for your TEMPpoint, VOLTpoint, or MEASURpoint instrument, 
use the LAN Configuration page of the web interface as follows:

1. From the LAN Configuration page, click Modify.

2. Specify the username as sysadmin, and specify the password (the default password is 
user). You can change the password, if you desire.

3. Uncheck the checkbox called Automatic private IP address enabled.

4. Click Static. 

5. Specify a static IP address for the instrument, so that is will be on the same subnet as your 
PC:

Note: You need a Simple Network Time Protocol (SNTP) time server on the LAN; 
otherwise, you need to provide a gateway. See your network administrator for more details.
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Reconfiguring the PC to Use a Static IP Address
After you have set up your instrument, you can reconfigure your PC to use a static IP address 
using this procedure:

1. From the Windows Start menu, click Settings, and then click Network Connections.

2. Right-click Local Area Connection, and select Properties.

3. In the General tab window, double-click Internet protocol (TCP/IP). 

4. Select Use the following IP address:, specify the static IP address and subnet mask that 
was initially assigned to the PC (see page 154), and click OK.

5. Renew the IP address of the computer. From the Windows Start menu, click Settings 
->Network Connections -> Local Area Connection -> Support -> Repair. 

Or, if you prefer to do this from the command prompt window, click Run from the 
Windows Start menu, enter cmd, and click OK to bring up the command prompt 
window. Then, from the command prompt window, enter:

ipconfig /renew renews the IP address
ipconfig /all checks the IP address
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ISO-Channel Technology
All TEMPpoint, VOLTpoint, and MEASURpoint products use ISO-Channel™ technology to 
eliminate common mode noise and ground loop problems.

This appendix includes two white papers that describe the benefits of using ISO-Channel 
technology.



About ISO-Channel Technology
Why ISO-Channel Technology is Your Best Return on 
Investment

When connecting signal sources to an instrument, it is important to eliminate the sources of 
error that can contribute to inaccuracies in your measurements. In most measurement 
instruments, this burden is on the customer. Instruments that use ISO-Channel technology, 
however, solve this problem for you – saving you tremendous setup and debug time and 
reducing costly grounding problems when connecting signals.

In today’s economy, we understand that every equipment decision needs to make good fiscal 
sense. This section describes why instruments with ISO-Channel technology offer you the best 
return on investment.

Understanding Ground Loops

When measuring signals, users often assume that the grounds of their signals and their 
measurement system are at the same potential. However, these ground potentials can differ 
by hundreds of millivolts.

If the difference in ground potential is large enough, current flows between the signal and 
your measurement system; this is called a ground loop (see Figure 40). Ground loops 
contribute noise that can greatly affect the accuracy of your measurements, especially when 
you are trying to measure low level signals precisely. Ground loop problems are the most 
common source of error in all measurements! Eliminating these errors, therefore, is critical 
when taking high accuracy measurements.

Figure 40: Measurement System with a Ground Loop

When a ground loop 
exists, the measured 
voltage, Vout, is the 
sum of the signal 
voltage, Vsource, and 
the ground potential 
difference, Vcm, which 
exists between the 
signal source ground 
and the measurement 
system ground. These 
errors often appear as 
transients or periodic 
signals in the 
measurement. For 
example, if a ground 
loop is formed with 50 
Hz or 60 Hz AC power 
lines, the unwanted AC 
signal appears as a 
periodic voltage error in 
the measurement.
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ISO-Channel Eliminates Ground Loops and Increases 
Common-Mode Rejection

ISO-Channel technology eliminates ground loop problems by using a differential, isolated, 
floating front-end. As you can see in Figure 41, a floating voltage signal is not referenced to 
system ground. 

Figure 41: Floating Signals

To measure floating signal sources, ISO-Channel technology uses differential analog input 
signals, a 24-bit Delta-Sigma A/D converter for each channel, and channel-to-channel 
isolation, as shown in Figure 42. 
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Figure 42: ISO-Channel Technology

Floating, Differential Signals

ISO-Channel technology implements a virtually ideal differential measurement system that 
reads only the potential difference between the positive and negative terminals of the 
amplifier. For each channel, the differential signals are isolated in that they are referenced to a 
ground reference point that is not connected to earth ground. Ground loop problems are 
eliminated by ensuring that only one ground reference is used for each channel in the 
measurement system. The signal sources are isolated from each other and from the 
measurement instrument.
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Figure 43: Differential Signals and Common-Mode Voltage

When the measurement instrument and signal source are at different ground potentials, the 
difference in potential is called common-mode voltage. The measurement instrument cannot 
discern between the signal and the common-mode voltage believing that the sum of these 
voltages is the actual signal. Of course, the common-mode potential is simply an error.

ISO-Channel technology provides common-mode rejection of 150 dB, which contributes an 
almost imperceptible error (33.5 million to 1) to Vout. Compare this to traditional data 
acquisition measurement instruments, which typically provide only 80 dB of common-mode 
rejection and therefore, contribute much more error on the order of 1 part per 10,000. 

Simultaneous Architecture

Many measurement instruments on the market today provide multiplexed architectures, 
where one A/D is used to measure multiple channels. In this kind of architecture, if one 
channel goes down, all channels go down.

ISO-Channel technology, on the other hand, uses a simultaneous architecture, where each 
channel has its own dedicated 24-bit Delta-Sigma A/D, as shown in Figure 44.
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Figure 44: Simultaneous vs. Multiplexed Architectures

Channel-to-Channel Isolation

Besides differential inputs, floating channels, and a simultaneous architecture, ISO-Channel 
technology provides channel-to-channel isolation, not just isolation from the analog front-end 
to the computer ground. With this kind of isolation, the channels are individually isolated 
from each other and from other system components. 

Typically, instrument manufacturers have used relays, isolation amplifiers, or optical isolation 
to provide channel-to-channel isolation. These methods have the following advantages and 
limitations:

• Relays – This technology provides good galvanic separation and can provide good 
accuracy and thermal properties, but relays are slow as they operate on one channel at a 
time (10 cycles/s), wear out over time, and are sensitive to magnetic fields. If one relay 
sticks, staying closed, the entire system fails! 

• Isolation amplifiers – Isolation amplifiers are used in multiplexed architectures. While 
they are solid-state, they are expensive, not as accurate, require more power, and generate 
more noise and heat than other solutions. 

• Optical isolation - Optical isolation is good in digital isolation systems but causes accuracy 
problems in analog isolation systems. It is also subject to long-term drift and requires 
considerably more power.

With ISO-Channel technology, the A/D is on the sensor side and has its own custom DC/DC 
converter. Then, optical or transformer isolation is used to transfer the A/D output data (the 
sensor data) digitally. And, due to the simultaneous architecture of ISO-Channel technology, 
all data is transferred in parallel.
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Summary

ISO-Channel technology offers built in system redundancy to protect your investment - if one 
channel fails, the remaining channels are completely unaffected! Instruments with 
ISO-Channel technology also adapt to the sensors that they are connected to, allowing a 
different ground reference for each signal without introducing errors! For these key reasons, 
ISO-Channel technology protects against problems in the field, and thereby, reduces costs – 
what a great return on your investment.
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Floating Signal Inputs Offer New Application 
Advantages

Precision measurement systems are often limited in that all inputs are connected to a single 
ground. Typically, multiplexer input configurations are set up this way, since all signal inputs 
are connected to the same return. Even differential input configurations use the same ground 
reference. The result is that accuracy and flexibility for accurate measurements can be severely 
compromised when noise or common mode voltage is present (see Figure 45).

Figure 45: In multiplexed systems, all inputs are connected to a signal ground, which can cause 
errors when noise or common mode voltage is present.

Crosstalk from one input signal can easily be reflected onto another input. The design 
movement to an A/D per channel can help this problem. But that is not sufficient in many 
cases (see Figure 46).
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Figure 46: Even when using an A/D per channel, noise can contribute errors to your measurement 
results.

To minimize noise and ground loops, some newer systems offer isolation between the input 
signal ground reference and the computer ground. This effectively separates the computer 
ground from the measurement portion of the system. But still, there is no isolation between 
input sensor channels, which is a common source of error and frustration for user 
applications. Why?

The assumption is made that all signal sources have the same exact ground reference. After 
all…ground is ground…isn’t it? Often this is not the case. For example, thermocouples for 
measuring temperature may be dispersed widely throughout an industrial setting, such as in 
the manufacture of air frames or in curing ovens. Grounds for these sensors may differ by 
several volts or even hundreds of volts. The resulting common mode voltage causes current to 
flow in the signal path, producing serious errors, which are very hard to diagnose and correct.

Isolating Each Input

Oftentimes it is NOT apparent that ground references from various sensors such as 
thermocouples, RTDs, strain gages, etc., are at different voltage potentials. Factors that can 
contribute to these ground differences are extensive wiring from long runs, crosstalk from 
motors or generators, or high source impedance from the signal source. Without recognizing 
this extraneous voltage, the measurement system “sees” this noise or common mode voltage 
as the actual signal. These unwanted noise sources lead to measurement errors (see Figure 47).
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Figure 47: Common mode voltage is present when different ground potentials exist in your 
measurement system.

In many applications, noise is a fact and a common occurrence. To prevent this noise from 
entering the signal path, the signal must be isolated on a channel-to-channel basis as well as 
from the PC ground reference. 

Technology breakthroughs now allow channel-to-channel isolation to be accomplished 
effectively. Using an A/D per channel with a DC-DC converter for each A/D allows each 
signal input channel to be isolated from one another (see Figure 48). With this individual 
isolation per channel, each input channel can now “float” to its own ground reference. 
Separate channels are then effectively isolated from each other by the isolation barrier, up to 
±500 V for each channel. Now any noise or common mode voltage to that level is eliminated 
from the system measurement, allowing pristine results from each sensor without any 
interaction from any other sensor.
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Figure 48: An A/D per channel and a DC-to-DC converter for each A/D provides channel-to-channel 
isolation, where each signal can float to its own ground reference.

Input channel return references are effectively separate instruments when the inputs are 
isolated. This individual isolation now allows the ground reference of each channel to 
measure at the level of this common mode voltage, up to ±500 V. This capability allows some 
new application ideas to flourish.

Measurement of two signals, as shown in Figure 49, can now have essentially 3 separate 
ground references: each signal input (signal 0 and signal 1) has a separate return reference; 
additionally, the PC has a third ground reference. This scheme can be extended for many 
signal inputs, such as 48 inputs in a single small measurement box, for a total of 49 different 
ground references.
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Figure 49: When measuring two input signals with channel-to-channel isolation, three ground 
references are provided (signal 0, signal 1, and PC ground).

New Application Derived from Isolated Channels

A typical application of measuring 48 channels of varying voltages from sensors, such as 
batteries, thermocouples, RTDs pressure sensors, etc., often must use different instruments 
because of the various ranges needed. Standard ranges of ±10 V may handle some 
applications, but not others, to the required resolution and accuracy.

With isolation per channel, combinations of channels can be used to measure higher voltage 
ranges. Figure 50 shows a configuration of 2 separate channels “ganged up” to measure a 
signal of up to 20 V. Normally each input would measure ±10 V. But, by using two identical 
channels, a range of twice that level can be accommodated. The output readings of each A/D 
are then summed to give the very accurate result. This is possible because the isolation 
between channels allows the return of the first channel to “float up” to a level halfway 
between the input signal. This reflects the accurate impedance balance of each input, and the 
high common mode rejection of each stage.
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Figure 50: Because each floating signal input is isolated from each other, you can use two separate 
channels, normally each configured for ±10V, to measure a ±20V signal. Simply sum the result of 

each channel to get your result.

Summary

When you need the highest accuracy and the most flexibility from your measurement system, 
ensure that floating signal inputs are provided. This approach allows noise-free 
measurements in tough industrial settings. It also saves countless days of tracking down 
erroneous readings that inevitably result if these precautions are not taken from the project’s 
beginning.
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